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Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©June 2011

Trademarks

Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
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R&TTE Directive
This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Direc-
tive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

CE Marking
This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark
is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and has issued a favorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
II
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FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.

And

2. This device must accept any interference, including interference that may cause undesired operation of the 
device.
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Preface
FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This 
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator 
and your body.


Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
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IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (Full Range AC/DC Adapter - AC Input 100 - 

240V, 50 - 60Hz DC Output 20V, 15A (300W) minimum).

This Computer’s Optical Device is a Laser Class 1 Product
V
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Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place where 
foreign matter or moisture may 

affect the system.

Don’t use or store the computer 
in a humid environment.

Do not place the computer on 
any surface that will block the 

Vents/Fan Intakes.
VI
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3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power until 
you properly shut down all pro-
grams.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
VII
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a steady, 

uninterrupted power supply. If you are unsure of your local power specifications, consult 
your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong 
is an important safety feature; do not defeat its purpose. If you do not have access to a 
compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by 
its wire.

• Make sure the socket and any extension cord(s) you use can support the total current load 
of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power sup-
plies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.


Power Safety 

Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
VIII
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Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

• Polymer batteries may experience a slight expansion or swelling, however this is part of the battery’s safety mecha-
nism and is not a cause for concern.

• Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See also the general battery precautionary information overleaf for further information.
IX
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General Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• If you do not use the battery for an extended period, then remove the battery from the computer for storage.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.


Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
X
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.


Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
XI



Preface
Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-

ware and software. Make sure your “papers” are handy.


Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer
from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
XII



Preface
On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
XIII
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the 
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on 
a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles 

when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent 

and short breaks are better than fewer and longer breaks.
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Lighting
Proper lighting and a comfortable viewing angle can reduce eye strain and shoulder and neck muscle fatigue.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

• Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.

Cable TV Safety
If you have included a TV Tuner in your purchase option then pay careful attention to the following:

• Make sure that your CATV system installer has connected the Coaxial cable shield to the grounding system of the 
building, as close to the point of cable entry as practical.

• This reminder is provided to call the CATV system installer’s attention to Article 820-93 of the NEC (Section 54, Part 
I of the Canadian Electrical Code).

• The TV antenna supplied with any TV Tuner module is intended for indoor use only. Please do not use your TV Tuner 
module outdoors.
XV



Preface
LCD Electro-Plated Logos
Note that in computers featuring a raised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear develops contact your service center.
XVI
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Quick Start Guide 1
Chapter 1: Quick Start Guide

Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, 
optical device, card reader), TouchPad & Mouse, Audio Features & Printer.

• Chapter 3 The computer’s power management options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s RAID, Wireless LAN, PC Camera, TV Tuner, Bluetooth & 

WLAN Combo and Security (Fingerprint and TPM) modules (some of which may be optional 
depending on your purchase configuration).

• Chapter 8 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the NVIDIA Video driver controls.
• Appendix C Information on the AMD Video driver controls.
• Appendix D The computer’s specification.
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Quick Start Guide1

Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “Drivers & Utilities” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer”
on page 6 - 1 in the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in this Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the
 symbol. Also please note the safety and handling instructions as indicated in the Preface.


Notes

Check the light colored
boxes with the mark
above to find detailed
information about the
computer’s features. 
1 - 2 Overview
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Not Included
Operating Systems (e.g. Windows 7) and applications (e.g. word processing, spreadsheet and database programs)
have their own manuals, so please consult the appropriate manuals.


Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the appropriate drivers. Drivers are programs which act as an interface between the computer and a hardware component
e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4 - 1, on page 4
- 3. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your
system hasn’t been properly configured (your service representative may have already done that for you), refer to “Drivers
& Utilities” on page 4 - 1 for installation instructions.

Ports and Jacks

See “Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your computer to com-
municate with external devices, connect to the internet etc.
Overview 1 - 3
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System Software
Your computer may already come with system software pre-installed. Where this is
not the case, or where you are re-configuring your computer for a different system,
you will find the Windows 7 operating system is supported.

Note: In order to run Windows 7 without limitations or decreased performance, your
computer requires a minimum 1GB of system memory (RAM).

RAID & AHCI Setup
Note that setting up a RAID, or AHCI mode, needs to be done prior to installing the
Windows OS (see “Setting Up SATA RAID Mode” on page 7 - 2).


TV Tuner Module 

Support

Note that the TV Tuner
module (factory) option
is supported by the Win-
dows Media Center
software. Windows Me-
dia Center is not includ-
ed in Starter or Home
Basic versions of Win-
dows 7.
1 - 4 Overview
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System Startup
1. Remove all packing materials, and place the computer on a stable surface.
2. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
3. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an 

outlet, and connect the AC power cord to the AC/DC adapter.
4. Use one hand to raise the lid/LCD to a comfortable viewing angle (it is preferable not to exceed 135 degrees); use 

the other hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the 
computer by the lid/LCD).

5. Raise the lid/LCD to a comfortable viewing angle, and press the power button.

Figure 1 - 1 - Computer with AC/DC Adapter Plugged-In/Opening the Lid/LCD


Shutdown

Note that you should always shut your computer down by choos-
ing the Shut Down command from the Start menu in Windows 7.
This will help prevent hard disk or system problems.

135
System Startup 1 - 5
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System Map: LCD Panel Open & Top ViewFigure 1 - 2 
LCD Panel Open 

& Top View

1. Built-In PC Camera
2. Built-In Microphone
3. LCD
4. LED Status Indicators
5. Touch Sensor Instant 

Keys
6. Speakers
7. Power Button
8. Keyboard
9. TouchPad and 

Buttons
10. Fingerprint Reader 

Module
11. LCD Panel Color 

LED

11

3

1

8

9

74


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable elec-
tronic transmission devices (e.g.
WLAN or Bluetooth) aboard air-
craft is usually prohibited. Make
sure any wireless modules are
OFF if you are using the comput-
er aboard aircraft.

Use the appropriate function key
combination to toggle power to
any wireless modules, and
check the indicators to see if any
modules are powered on or not
(see Table 1 - 3, on page 1 - 8).

6 6
66

5

4 5 5

22

10

6

1 - 6 System Map: LCD Panel Open & Top View
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LED Indicators
The LED indicators display helpful information about
the current status of the computer.

Table 1 - 1 - LED Status Indicators

Table 1 - 2 - LED Power Indicators

Icon Color Description

Blue Scroll Lock is Activated

Blue Caps Lock is Activated

Blue Number Lock is Activated

Blinking Blue Hard Disk Activity

Icon Color Description

Orange DC Power is Plugged In

Green The Computer is On

Blinking
Green

The Computer is In Sleep Mode

Orange The Battery is Charging

Blinking 
Orange

The Battery has Reached 
Critically Low Power Status

Green The Battery is Fully Charged
System Map: LCD Panel Open & Top View 1 - 7
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Touch Sensor Instant Keys
Press the Touch Sensor Instant Keys on the computer to toggle the appropriate function on/off. When a module
is powered on the appropriate icon will be highlighted blue. 

Table 1 - 3 - Touch Sensor Instant Keys

Note that you can also use the function key combinations for all of the functions above (see page 1 - 10).

Icon Description

Mute Toggle 

Bluetooth Module (optional) Power Toggle

Wireless LAN Module (optional) Power Toggle

PC Camera Module Power Toggle

Volume Control (Press and hold your finger at either end  /  of the volume control 
to adjust the system volume)
1 - 8 Touch Sensor Instant Keys
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Keyboard
The keyboard has an embedded numerical keypad for easy numeric data input, and
features function keys to allow you to change operational features instantly. See
Table 1 - 4, on page 1 - 10 for full function key combination details.

Figure 1 - 3 - Keyboard


Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial functions/hot-keys
unique to the system’s
regular keyboard may not
work.

Num Lk & Scr Lk

Hold down the Fn Key
and Scr Lk/Num Lk to en-
able scroll lock/number
lock, and check the LED
indicator for status. 

Numerical 

Play/Pause Key

Function Keys

NumLk & 
ScrLk Keys

Fn Key

 Keypad 



Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLk is on.
Keyboard 1 - 9
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Function Keys & Visual Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition to the
basic function key combinations; visual indicators (see the table below) are available when the Hot Key driver is in-
stalled (see “Hot Key” on page 4 - 8). After installing the driver an icon  will appear in the taskbar.

Table 1 - 4 - Function Keys & Visual Indicators

Keys Function/Visual Indicators Keys Function/Visual Indicators

Fn + ~ Play/Pause (in Audio/Video Programs) Fn +F8/F9
Brightness Decrease/

Increase

Fn + F1 Touchpad Toggle Fn + F10
PC Camera Power 

Toggle

Fn + F2
Turn LCD Backlight Off 

(Press a key to or use Touchpad to turn on)
Fn + F11

*WLAN Module 
Power Toggle

Fn + F3 Mute Toggle Fn + F12
Bluetooth Module 

Power Toggle

Fn + F4 Sleep Toggle Fn + NumLk Number Lock Toggle

Fn +F5/F6
Volume Decrease/

Increase
Fn + ScrLk Scroll Lock Toggle

Fn + F7 Display Toggle - DO NOT use when SLI is enabled Fn + 5
Audio Toggle - Toggle between Stereo and 5.1 Sur-

round Sound Modes
1 - 10 Keyboard
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System Map: Front & Rear Views Figure 1 - 4
Front View

1. ExpressCard Slot 
(see page 2 - 7)

2. Consumer Infrared 
Transceiver 
(enabled with 
optional TV Tuner 
only)

3. LED Power 
Indicators

4. DC-In Jack
5. Vent/Fan Intake

3

4

2

5 5


TV Tuner Module Support

Note that the TV Tuner module (factory) option is supported by the Windows Media Cen-
ter software. Windows Media Center is not included in Starter or Home Basic versions
of Windows 7.

5 5

1

System Map: Front & Rear Views 1 - 11
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System Map: Right ViewFigure 1 - 5
Right View

1. Line-In Jack
2. S/PDIF-Out Jack
3. Microphone-In Jack
4. Headphone-In Jack
5. 3 * USB 2.0 Ports
6. Security Lock Slot

1 53 42 6


USB Ports

Note that the connections to the USB ports only fit one way, do not force them.

5 5



USB 2.0 or 3.0 Ports

USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. 
1 - 12 System Map: Right View
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System Map: Left View Figure 1 - 6
Left View

1. Speaker
2. DVI-Out Port
3. Cable (CATV) 

Antenna Jack*
4. RJ-45 LAN Jack
5. HDMI-Out Port
6. 2 * USB 3.0 Ports
7. eSATA Port
8. Mini-IEEE 1394b Port
9. 9-in-1 Card Reader
10. Optical Device Drive 

Bay

*Enabled with Optional
Mini-PCI TV Tuner Only


Mini-IEEE 1394b Port

The Mini-IEEE 1394b port
only supports SELF POW-
ERED IEEE 1394 devices.

1

2 3 4
5 96

8


USB 3.0 Ports

USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. Note that
the USB 3.0 port requires a driver installation (see “USB 3.0” on page 4 - 7), does not
support wake on USB and is not operational under DOS.

9-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RSMMC
SD (Secure Digital) / Mini SD / SDHC / SDXC Compatible

MS (Memory Stick) / MS Pro / MS Duo

HDMI Ports

Note that the HDMI Ports support video and audio signals to attached external displays 
(also see “HDMI Ports” on page 2 - 7).

76

10
System Map: Left View 1 - 13
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Disk Eject Warning

Don’t try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don’t try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.


Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code.

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.
1 - 14 System Map: Left View
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System Map: Bottom View Figure 1 - 7
Bottom View

1. Sub Woofer
2. Fan Outlet/Intake
3. Component Bay 

Cover
4. Battery 

(Secondary HDD 
Bay - HDD3)

5. Primary HDD Bay 
(HDD1 & 2)


Overheating

To prevent your comput-
er from overheating make
sure nothing blocks the
vent(s)/fan intake(s)
while the computer is in
use.

1

2

4 5


Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges. See “Battery Information” on page 3 - 10 for full instructions.

3

2 2
System Map: Bottom View 1 - 15
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Windows 7 Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

Figure 1 - 8 - Start Menu & Control Panel

Click here to toggle Category View

 

1 - 16 Windows 7 Start Menu & Control Panel



Quick Start Guide 1
Video Features
This computer features two different (either AMD or NVIDIA) video options. You can switch display devices,
and configure display options, from the Display control panel (in Appearances and Personalization) in Win-
dows 7. 

To access Display (Control Panel) and Screen Resolution in Windows:
1. Click Start and click Control Panel.
2. Click Display (icon) - In the Appearances and Personalization category.
3. Click Adjust Screen Resolution/Adjust resolution.
OR
4. Alternatively you can right-click the desktop and select Screen resolution  (Figure 1 - 9 on page 1 - 18).
5. Use the dropbox to select the screen Resolution  (Figure 1 - 9 on page 1 - 18).

1
2


NVIDIA & AMD Video Controls

More detailed video controls are provided by the NVIDIA Control Panel or Catalyst Control Center. For more detailed
information see  see “NVIDIA Control Panel” on page 1 - 19/“Catalyst Control Center” on page 1 - 20 and Appendix
B or Appendix C.

You can also access the control panels by right-clicking the desktop and selecting NVIDIA Control Panel/Catalyst (TM)
Control Center (Figure 1 - 10 on page 1 - 19/Figure 1 - 11 on page 1 - 20).
Video Features 1 - 17
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Screen Resolution

Figure 1 - 9 - Screen Resolution

2


Video Options

Note that card types, specifica-
tions and drivers are subject to
continual updates and changes.
Check with your service center
for the latest details on video
cards supported.

1

1 - 18 Video Features
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NVIDIA Control Panel
You can access the NVIDIA Control Panel as follows:

1. Click Start, and click Control Panel.
2. Click NVIDIA Control Panel  (Figure 1 - 10) - In the Appearances and Personalization category.
3. See “NVIDIA Video Driver Controls” on page B - 1 for full details on control panels etc.
OR
4. You can also access the control panel by right-clicking the desktop and selecting NVIDIA Control Panel .

Figure 1 - 10 - NVIDIA Control Panel

1

2

2

1

Video Features 1 - 19
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Catalyst Control Center
You can access the CatalystTM Control Center as follows:

1. Right-click the desktop and select Catalyst Control Center  (Figure 1 - 11).
OR

2. Double-click the icon   (Figure 1 - 11) in the Windows notification area (or right-click the icon and select
Catalyst Control Center).

3. See “AMD Video Driver Controls” on page C - 1 for full details on control panels etc.

Figure 1 - 11 - Catalyst Control Center Access

1

2

1

Right-Click
for Menu

2

1 - 20 Video Features
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Power Options
The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 16) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change plan settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 10.

Figure 1 - 12 - Power Options
Power Options 1 - 21
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Chapter 2: Storage Devices, Mouse, Audio & 
Printer

Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive
• Optical Device
• Multi-In-1 Card Reader
• ExpressCard Slot
• Audio Features
• HDMI Audio Configuration
• Adding a Printer
Overview 2 - 1
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 Hard Disk Drive
The hard disk drive(s) issuer) used to store your data in the computer. The hard
disks) can be taken out to accommodate other 2.5" serial (SATA) hard disk drives
with a height of 9.5 mm. The primary hard disk bay  is accessible from the bottom
of your computer as seen below, and the secondary hard disk bay  is located under
the battery compartment.

The computer can accommodate up to three hard disks (two in the primary bay, and
one in the secondary bay), and these may be configured in RAID or AHCI modes.
Further details on removing and inserting the hard disk are available in “Upgrading
the Hard Disk Drive(s)” on page 6 - 4.


Power Safety

Before attempting to ac-
cess any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

 Figure 2 - 1
Hard Disk Location

1

2

1
2

2 - 2 Hard Disk Drive
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Optical Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the model you purchased (see “Storage” on page D - 3). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set in the BIOS (see “Boot Menu” on page 5 - 15).

Loading Discs
To insert a CD/DVD, press the open button  and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you
are ready to start. The busy indicator  will light up while data is being accessed,
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency eject hole

 to open the tray.


Sound Volume 

Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows. Click the Volume
icon on the taskbar to
check the setting. 

Peripherals must be
connected before you
turn on the system.

 Figure 2 - 2
Optical Device

1

2

3

12 3
Optical Device 2 - 3
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Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.


CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.
2 - 4 Optical Device
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DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 14.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South 
Africa, Middle East & Egypt

3
South-East Asia, Taiwan, South 

Korea, The Philippines, Indonesia, 
Hong Kong

4
South & Central America, Mexico, 

Australia, New Zealand

5 N Korea, Russia, Eastern Europe, 
India & Most of Africa

6 China

Table 2 - 1
DVD Regional Coding
Optical Device 2 - 5
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 Multi-In-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the card reader driver (see
“Card Reader” on page 4 - 7).

Note: Some of these cards require PC adapters that are usually supplied with the
cards.


Card Reader Cover

Make sure you keep the
cover in the card reader
when not in use. This
will help prevent foreign
objects and/or dust get-
ting in to the card read-
er.

 Figure 2 - 3
Right View

1. Card Reader

• MMC (MultiMedia Card) / RSMMC
• SD (Secure Digital) / Mini SD / SDHC / SDXC
• MS (Memory Stick) / MS Pro / MS Duo

1

2 - 6 Multi-In-1 Card Reader
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ExpressCard Slot
The computer is equipped with an ExpressCard/34 slot that reads Express Card/34
formats. ExpressCards are the successors to PCMCIA (PC Cards). 

Inserting and Removing ExpressCards
• Press the cover to eject it before inserting an ExpressCard.
• Align the ExpressCard with the slot and push it in until it locks into place.
• To remove an ExpressCard, simply press the card to eject it.


ExpressCard 

Slot Cover

Make sure you keep the
cover in the Express-
Card slot when not in
use. This will help pre-
vent foreign objects and/
or dust getting in to the
ExpressCard Slot.

 Figure 2 - 4
Express Card Slot

1. ExpressCard 
Slot

1

ExpressCard Slot 2 - 7
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 Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the Realtek HD Audio Manager  icon in the taskbar/
control panel (right-click the taskbar icon  to bring up an audio menu). The volume
may also be adjusted by means of the Fn + F5/F6 key combination or by pressing
your finger on either end of the Touch Sensor volume control (see Table 1 - 3, on
page 1 - 8). 


Sound Volume 

Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the taskbar to
check the setting.

 Figure 2 - 5
Realtek Audio 

Manager

Right-click the icon 
to access the menu 
above.

See “HDMI Audio Configuration” on page 2 - 13 for a description of the audio configuration
when connecting an HDMI supported display device.
2 - 8 Audio Features
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Setup for Audio Recording
To record audio sources on your computer at optimum quality follow the instruc-
tions below:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel) 
and make sure you are in Classic View.

2. Click Realtek HD Audio Manager (or right-click the taskbar icon  and select 
Sound Manager).

3. Click Microphone Effects (tab) in Microphone (tab), and then click to select 
Noise Suppression (button), or adjust the Recording Volume level to around 60, 
to obtain the optimum recording quality.

4. Click OK to close the control panel and save the settings.

 Figure 2 - 6
Realtek Audio 

Manager - 
Recording Setup
Audio Features 2 - 9
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Setup for 5.1 or 7.1 Surround Sound
To setup your system for 5.1 or 7.1 surround sound you will need to connect the au-
dio cables to the Headphone-Out, Line-In,  Microphone-In jack and S/PDIF-Out
jacks (note: the S/PDIF jack is used for 7.1 surround sound only) .

1. Click Start, and click Control Panel (or point to Settings and click Control Panel) 
and make sure you are in Classic View.

2. Click Realtek HD Audio Manager (or right-click the taskbar icon  and select 
Sound Manager).

3. Click Speakers (tab) and click Speaker Configuration (tab).
4. Select 5.1 or 7.1 Speaker from the Speaker Configuration pull-down menu.


Fn + 5 Audio Toggle

The Fn + 5 key combi-
nation allows you to tog-
gle the audio system
between stereo and sur-
round modes. The ste-
reo mode will allow for a
louder audio volume.

Note that if you have
stereo mode enabled,
and attempt to demo the
speaker configuration,
then the sound will only
be enabled through the
front and rear speakers.

 Figure 2 - 7
Speaker 

Configuration (7.1)


Auto Popup Dialog

You should enable the
auto popup dialog to au-
tomatically detect when a
device has been
plugged-in. If disabled,
double-click connector
settings  and click the
box to enable the auto
popup detection of
plugged-n devices.

Connector Settings
2 - 10 Audio Features
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5. Plug the front speaker cables into the Headphone-Out Jack.
6. Plug in the other cables (you may require an adapter to connect each cable to the 

appropriate jack e.g a stereo mini to dual RCA adapter) from your speakers as 
follows:

• Line-In Jack = Rear Speaker Out
• Microphone-In Jack = Center/Subwoofer Speaker Out
• S/PDIF-Out Jack = Side Speaker Out (for 7.1 Surround Sound Only)

7. As you plug in each cable a dialog box will pop up (see “Auto Popup Dialog” on 
page 2 - 10).

8. Click to put a tick in the appropriate box according to the speaker plugged-in (e.g. 
Rear Speaker Out), and then click OK to save the setting.

9. Click OK to exit Realtek HD Audio Manager. 

 Figure 2 - 8
Connected Device 

Auto Popup 

Note: Side Speaker Out is required for 7.1 Surround only.
Audio Features 2 - 11
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Dolby Settings
You can adjust the Dolby settings from the Dolby tab in Speakers Properties.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Playback (tab).
4. Double-click Speakers (or select Properties from the right-click menu).
5. Click Dolby (tab)
6. Adjust the settings to your preferences and click OK.

 Figure 2 - 9
Speakers Properties 

Dolby Settings
2 - 12 Audio Features



Storage Devices, Mouse, Audio & Printer

2

HDMI Audio Configuration
As HDMI (High-Definition Multimedia Interface) carries both audio and video sig-
nals you can configure the audio output as per the instructions below.

Audio Setup for HDMI
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Playback (tab), and click to select Realtek Digital Output.
4. Click Set Default (button).
5. Click OK to close the Sound  control panel.
6. Select Speakers as the default for standard audio sources.

Figure 2 - 10
Sound Playback 

Options
Audio Features 2 - 13
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Audio Setup for LCD Monitors/TVs with HDMI Input
Some LCD monitors/TVs support HDMI input, but DO NOT have built-in digital
audio decoders. Where this is the case, when playing DVDs in Windows Media
Player/CyberLink Power DVD, a background noise can occur. If this situation does
arise then please follow the instructions below.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Double-click Realtek Digital Output.
4. Click Supported Formats (tab).
5. Click to disable (remove the check in the box) DTS Audio and Dolby Digital.
6. Click OK and close the control panels.

 Figure 2 - 11
Sound 

Supported Formats
2 - 14 Audio Features
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HDMI Notes
• Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-

ing to play audio/video sources through the device.

• If you disconnect the HDMI cable the default audio playback device will not 
revert to speakers until the computer is restarted (if you do not wish to restart the 
computer then go to the Sound control panel and select Speakers as the default 
audio playback device).

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “Configuring an

External Display using the NVIDIA Control Panel” on page B - 7.
3. Set up your external display (TV or LCD) for HDMI input (see your display device

manual).
4. You can now play video/audio sources through your external display.


 Other Applications

If you are using a third
party application to play
DVDs etc. you will need
to consult the applica-
tion’s documentation to
see the appropriate au-
dio configuration (the
application must support
digital to analog transla-
tion).
Audio Features 2 - 15
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 TouchPad and Buttons/Mouse
The TouchPad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The TouchPad buttons function in
much the same way as a two-button mouse.


Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’s user docu-
mentation for details.
2 - 16 TouchPad and Buttons/Mouse
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Once you have installed the TouchPad driver (see “TouchPad” on page 4 - 8) you
can configure the functions from the Mouse control panel in Windows, or by double-
clicking the TouchPad driver icon  on the taskbar. You may then configure the
TouchPad tapping, buttons, scrolling, pointer motion and sensitivity options to your
preferences. You will find further information at www.synaptics.com.


TouchPad Scrolling

This computer model se-
ries may feature different
TouchPad versions.

These TouchPads may
differ in their vertical
scrolling function in most
scrollable windows.

Some TouchPads require
sliding the finger up and
down on the right of the
TouchPad to scroll the
window. Other versions
require tapping/holding
down the finger at the top
right or bottom right of the
TouchPad to scroll the
window.

 Figure 2 - 12
Mouse Properties
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Gestures and Device Settings
The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
tion) on the surface of the TouchPad to perform specific actions to manipulate doc-
uments, objects and applications.

You can configure the settings from the Device Settings tab in Mouse Properties:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Mouse (Hardware and Sound).
3. Click Device Settings (tab) and click Settings.
4. Use the menu tree on the left to access the user configurable settings.


Show Video

You can get a clearer
view of the gestures in-
volved by clicking the
Show Video option for
each gesture item.

Select the gesture (Pinch
Zoom, Rotating, Three
Fingers Down and
Three Finger Flick) in the
Device Settings > Set-
tings left tree menu
and click the Show Video
button to see the demon-
stration video.

For more details on any of
the gestures see the help
in the lower part of the
right menu window.

 Figure 2 - 13
Mouse Properties - 

Device Settings
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Scrolling
The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the
TouchPad surface and slide both fingers in the direction required (in a straight con-
tinuous motion).

Zooming
The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the TouchPad (for best results use the tips of the fingers) and
slide them apart to zoom in, or closer together to zoom out.

 Figure 2 - 14
Scrolling Gesture

 Figure 2 - 15
Zooming Gesture
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Rotating
Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another
finger near the middle of the TouchPad and slide it in a circular motion around the
stationary finger (clockwise or counterclockwise) to rotate the object.

Three Finger-Flick/Three Fingers Down (Press)
The Three Finger-Flick gesture may be used to enhance navigation with a variety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-selectable applications.

 Figure 2 - 16
Rotating Gesture

 Figure 2 - 17
Flick/Press 

Gesture
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Adding a Printer
The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer
Most new printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-

tridge etc.). 
2. Turn ON the computer.
3. Turn ON the printer. 
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you 

to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar
(you will need to purchase a parallel to USB converter).


Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer’s
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
Adding a Printer 2 - 21
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Chapter 3: Power Management

Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system.

This chapter covers:

• The Power Sources
• Turning On the Computer
• Power Plans
• Power-Saving States
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.


OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system. 

(Note: All pictures used
on the following pages
are from the Windows 7
OS.)
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components (see page D - 5).

1. Attach the AC/DC adapter to the DC-In jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page 3 - 14).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 10.
3 - 2 The Power Sources
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Turning On the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options in the Windows control panel to configure this feature.


Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

Power Button as 
Stand by or 

Hibernate Button

You can use the OS’s
Power Options control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
bernate mode (see your
OS’s documentation, or
“Configuring the Pow-
er Buttons” on page 3
- 8 for details).


Shut Down

Note that you should always shut your computer down by choosing the Shut Down com-
mand from the bottom right of the Start menu in Windows. This will help prevent hard disk
or system problems.
Turning On the Computer 3 - 3
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.


Resuming 
Operation

See Table 3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 1
Power Plan 

Advanced Settings
(Win 7)
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance (you may need to click Show additional plans to view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Figure 3 - 2
Power Plans (Win 7)

Click to Show/Hide 
additional 
power plans
Power Plans 3 - 5
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Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where
you left off. Win 7 uses the Sleep, Hibernate and Shut Down power-saving states.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.
3 - 6 Power-Saving States
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut down
You should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hibernate.

Figure 3 - 3
Start Menu Power

Win 7
Power-Saving States 3 - 7
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to a power-saving state. Click Choose what the power buttons do on
the left menu in Power Options to bring up the menu.


Password 
Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 4
Power Options 
Define Power 

Buttons
3 - 8 Configuring the Power Buttons
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F4 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button (Fn + F4 Key Combo)

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/Touchpad


Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table 3 - 1
Resuming 

Operation


Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).
Configuring the Power Buttons 3 - 9
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Battery Information
Follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Change plan settings > Change advanced power settings (see Figure
3 - 1 on page 3 - 4).

Click the battery icon  in the taskbar to see the current battery level and charge
status.


Low Battery 

Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 5
Battery Icon 

(Taskbar) & Battery 
Advanced Settings
3 - 10 Battery Information
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are 
not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, 
ExpressCards etc.


Windows Mobility 

Center

The Windows Mobility
Center control panel
provides an easy point
of access for information
on battery status, power
plans used and wireless
device status etc.

Figure 3 - 6
Windows Mobility 

Center
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see “Removing the Battery”
on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 14 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 7 for information on the battery charge status, and to “Battery In-
formation” on page 3 - 10 for more information on how to maintain and properly
recharge the battery pack.)
3 - 12 Battery Information
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances.
• DO NOT expose the battery to fire or high temperatures, it may explode.
• DO NOT connect the metal terminals (+, -) to each other.


Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.


Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.
Battery Information 3 - 13
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure 3 - 7
Power Plan Create
3 - 14 Battery Information
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3. Click Change plan settings (after creating it) and click Change plan settings > 
Change advanced power settings.

Figure 3 - 8
Change Plan 

Settings / Change 
Advanced Power 

Settings
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

• Low battery levels = 0%
• Critical battery Levels = 1%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

Figure 3 - 9
Power Options 

Advanced Settings - 
Battery
3 - 16 Battery Information
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.


SLI Multi GPU Configuration & Battery Power

Note that due to the high power and system demands created by enabling SLI Configura-
tion, you should not enable SLI configuration if your computer is powered by battery
only. If you attempt to run an SLI configuration when the computer is powered by the bat-
tery only, then system problems may occur.

If the computer is currently powered by battery only do not enable SLI configuration. 

If you have currently enabled SLI configuration, and the computer is powered by the AC/
DC adapter, do not switch to battery power only (or go to the NVIDIA Control Panel and
disable SLI configuration before switching to battery power only).
Battery Information 3 - 17
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utili-
ties essential to the operation or improvement of some
of the computer’s subsystems. The system takes ad-
vantage of some newer hardware components for
which the latest versions of most available operating
systems haven’t built in drivers and utilities. Thus,
some of the system components won’t be auto-config-
ured with an appropriate driver or utility during oper-
ating system installation. Instead, you need to
manually install some system-required drivers and
utilities.

RAID & AHCI Setup
Note that setting up a RAID, or AHCI mode, needs to
be done prior to installing the Windows OS, and there-
fore before installing the other drivers listed here (see
“Setting Up SATA RAID Mode” on page 7 - 2).

What to Install
The Device Drivers & Utilities + User’s Manual disc
contains the drivers and utilities necessary for the
proper operation of the computer.

Table 4 - 1, on page 4 - 3 lists what you need to install
and it is very important that the drivers are in-
stalled in the order indicated.

Module Driver Installation
The procedures for installing drivers for the WLAN,
PC Camera, Consumer Infrared (for TV tuner re-
mote), Bluetooth & WLAN Combo and Security
(Fingerprint & TPM modules) are provided in
“Modules” on page 7 - 1.
What to Install 4 - 1
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Driver Installation
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button), or Option Driv-
ers (button) to access the Optional driver menu.

Figure 4 - 1 - Drivers Installer Screen 1

1. Check the driver installation order from Table 4 - 1, 
on page 4 - 3 (the drivers must be installed in 
this order) which is the same as that listed in the 
Drivers Installer menu below.

2. Click to select the driver you wish to install, (you 
should note down the drivers as you install them).

3. Follow the instructions for each individual driver 
installation procedure as listed on the following 
pages.

Figure 4 - 2 - Drivers Installer Screen 2
4 - 2 Driver Installation
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Table 4 - 1 - Driver Installation

Note that you need to install both the WLAN & Bluetooth drivers for Intel and 3rd party WLAN & Bluetooth
Combo modules.

Windows 7 Driver Page Windows 7 Driver Page

Chipset Page 4 - 7 Intel Rapid Storage Technology (for RAID) Page 7 - 8

Video (NVIDIA)
Video (AMD)

Page 4 - 7 Wireless LAN Module Page 7 - 15

LAN Page 4 - 7 PC Camera Module Page 7 - 33

Card Reader Page 4 - 7 TV Tuner Module Page 7 - 41

TouchPad Page 4 - 8

Bluetooth Module
(note that you need to install both the WLAN & 
Bluetooth drivers for the WLAN & Bluetooth 
Combo module)

Page 7 - 44

USB 3.0 Page 4 - 8 Fingerprint Reader Module Page 7 - 60

Hot Key Page 4 - 8 Trusted Platform Module Page 7 - 67

Audio Page 4 - 8
Driver Installation 4 - 3
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Manual Driver Installation
Click the Browse CD/DVD button in the Drivers In-
staller application and browse to the executable file in
the appropriate driver folder.

Windows Update
After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update” on page 4 -
9 for instructions.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and 
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.
4 - 4 Driver Installation
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User Account Control
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue/Al-
low, and follow the installation procedure as directed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or Install to continue the in-
stallation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.
Driver Installation 4 - 5
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers (button), or Option Drivers
(button) to access the Optional driver menu.

RAID Note: Setting up a RAID, or AHCI mode, needs to be done prior to installing the Windows OS, and there-
fore before installing the other drivers listed here.


Driver Installation General Guidelines

The driver installation procedure outlined in this
Chapter (and in Chapter 7 Options & Modules),
are accurate at the time of going to press.

Drivers are always subject to upgrade and revision
so the exact procedure for certain drivers may differ
slightly. As a general guide follow the default on
screen instructions for each driver (e.g. Next > Next
> Finish) unless you are an advanced user. In many
cases a restart is required to install the driver.
4 - 6 Driver Installation
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Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

The video driver installation procedure will depend
upon which video adapter is included in your purchase
option (NVIDIA or AMD).

Video (NVIDIA)
1. Click 2.Install Video Driver > Yes.
2. Click AGREE AND CONTINUE (button) to 

accept the terms of the license agreement.
3. Click NEXT.
4. Click the RESTART NOW button to restart 

the computer.

After the video driver has been installed, and the sys-
tem restarted, the OS will automatically run the "Win-
sat.exe" to rate the performance. Allow time for this
process to finish and do not restart during this process
(if you have restarted the system see “Windows Up-
date” on page 4 - 9).

Video (AMD)
1. Click 2.Install Video Driver > Yes.
2. Click Next > Install (button).
3. Click the Express (or Custom if you prefer to 

manually configure the driver installation set-
tings) button and click Next.

4. Click Accept (button) and click Yes.
5. Click Finish > Yes to restart the computer.
6. After the computer has restarted, click Restart 

Now to restart again to refresh the video driver.

LAN
1. Click 3.Install LAN Driver > Yes.
2. Click Install.
3. Click Finish to complete the installation.

Card Reader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Install > Finish.
Driver Installation 4 - 7
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TouchPad
1. Click 5.Install Touchpad Driver > Yes. 
2. Click Next.
3. Click the button to accept the license, and then 

click Next.
4. Click Finish > Restart Now to restart the com-

puter.

USB 3.0
1. Click 6.Install USB 3.0 Driver > Yes. 
2. Click Next.
3. Click the button to accept the license and then 

click Next.
4. Click Next > Install.
5. Click Finish.

Hot Key
1. Click 7.Install Hotkey AP > Yes.
2. Click Next > Next.
3. Click Finish > Finish to restart your computer.

Audio
1. Click 8. Install Audio Driver > Yes.
2. Click Next.
3. Click Finish to restart the computer.

It is recommended that you install the Intel Rapid
Storage Technology driver (see “Intel Rapid Storage
Technology” on page 7 - 8 - required for AHCI &
RAID mode).

(see over)
4 - 8 Driver Installation
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4. Windows Experience Index
After the drivers are installed follow this procedure to
ensure an accurate rating from the Windows Experi-
ence Index (make sure the AC/DC adapter is plugged
in):

1. Click Start, and click Control Panel.
2. Click Performance Information and Tools 

(System and Security > System > Check the 
Windows Experience Index).

3. Click “Rate this computer/Refresh Now/Re-
run the assessment”.

4. The computer will take a few minutes to assess 
the system performance.

5. Close the control panel.


Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Click Windows Update (System and Security/
Security).

3. Click Check for updates (button).
4. The computer will now check for updates (you 

need to be connected to the internet).
5. Click Install now (button) to begin checking for the 

updates.
6. Click Install updates (button) to install the 

updates.
Driver Installation 4 - 9



Drivers & Utilities

4

Optional Drivers
See the pages indicated for the driver installation pro-
cedures for any modules included in your purchase op-
tion.

Figure 4 - 3 - Optional Drivers Installer Screen

RAID Setup
Note: Prior to setting up the RAID you will need to use
an operable computer to copy the RAID driver to a
USB flash drive before installing the Windows operat-
ing system. See “Setting Up SATA RAID Mode” on
page 7 - 2 for configuration instructions.

Bluetooth Module
If your purchase option includes the standalone V2.1
Bluetooth module then no driver is required. If your
purchase option includes the Combination Wireless
LAN & V3.0 Bluetooth module then install the driver
as instructed in “3rd Party Bluetooth Combo Driver
Installation” on page 7 - 46 or “Intel Bluetooth Com-
bo Driver Installation” on page 7 - 54.

Wireless LAN
See the appropriate install procedure for your WLAN
module in “Click Advanced and click Verify, then
click Verify (button) to begin the process.” on page 7
- 13.
4 - 10 Driver Installation



Drivers & Utilities

4

PC Camera
See the install procedure in “PC Camera Module” on
page 7 - 32.

Consumer Infrared (for TV Tuner Remote)
See the install procedure in “TV Tuner Module” on
page 7 - 40.

Security Modules (Fingerprint & TPM)
See the install procedures in “Fingerprint Reader
Module” on page 7 - 60 and “Trusted Platform Mod-
ule” on page 7 - 65.
Driver Installation 4 - 11
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Chapter 5: BIOS Utilities

Overview
This chapter gives a brief introduction to the computer’s built-in software: 

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility 
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.


BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages. 
Overview 5 - 1
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The Power-On Self Test (POST)
If you enable the Boot-time Diagnostic Screen in the Setup Utility, each time you
turn on the computer the system takes a few seconds to conduct a POST, including
a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.


POST Screen

1.BIOS information
2.CPU type 
3.Memory status
4.Enter Setup prompt

appears only during
POST

Note: The POST screen
as pictured right is for
guideline purposes only.
The POST screen on
your computer may ap-
pear slightly different. If
the Boot-time Diagnos-
tic Screen is disabled
(see page 5 - 9 as per the
default setting), the POST
screen will not appear.

Figure 5 - 1
POST Screen

1

23

4

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct
configuration. 

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.
The Power-On Self Test (POST) 5 - 3
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The Setup Utility
The Phoenix Setup utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

Entering Setup
To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen in Figure 5 - 1 on page 5 - 2 is usually present for a
few seconds after you turn on the system. If you get a “Keyboard Error”, (usually
because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.


BIOS Settings 

Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.
5 - 4 The Setup Utility
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Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screen to
make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the
screen. If these tools are confusing, press F1 to call up a General Help screen, and
then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.


Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.
The Setup Utility 5 - 5
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 2
Main Menu
5 - 6 Main Menu
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System/Extended Memory: (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

BIOS Revision/VGA Card etc. (Main Menu)
This item contains information on the BIOS version and video card etc., and is not
user configurable.
Main Menu 5 - 7
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Advanced Menu

Advanced Chipset Control (Advanced Menu)
The sub-menu here allows you to enable/disable some advanced system features.

Figure 5 - 3
Advanced Menu
5 - 8 Advanced Menu
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SATA Mode Selection (Advanced Menu)
You may enable/disable SATA RAID or AHCI mode for your hard disks, however
you should only enable/disable SATA RAID or AHCI BEFORE installing an
operating system, and after you have backed up all necessary files and data (see
sidebar). See “Setting Up SATA RAID Mode” on page 7 - 2 for details.

Legacy USB Support: (Advanced Menu)
Choose “Enabled” if you intend to use USB devices in systems which do not nor-
mally support USB functionality (e.g. DOS). The default setting is “Enabled” and
does not need to be changed if you intend to use your USB devices in Windows.

Boot-time Diagnostic Screen: (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen. Enable this
item to display the POST screen (see “The Power-On Self Test (POST)” on page 5
- 2).

Reset Configuration Data (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have in-
stalled a new add-on which has reconfigured the system, resulting in such a serious
system conflict that the operating system is unable to boot.


SATA Mode

If you have installed the
Windows 7 operating
system with either AHCI
or RAID mode enabled,
DO NOT disable the set
mode (if you wish to dis-
able the set mode you
will need to reinstall the
Windows 7 OS).
Advanced Menu 5 - 9
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Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep: (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
5 - 10 Advanced Menu
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Advanced Chipset Control Menu

Bluetooth Power Setting > Advanced Chipset Control
You can adjust the Bluetooth module power setting to your preference. The default
setting (Disabled) will see the Bluetooth module powered off when the system is
started up or restarted. Enabling the power setting will have the module retain the
last power status (on or off) before any restart or shut down.

Figure 5 - 4
Advanced Chipset 

Control Menu
Advanced Chipset Control Menu 5 - 11
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Intel Virtualization Technology > Advanced Chipset Control
Intel(R) Virtualization Technology enables a CPU to act as if it were several CPUs
working in parallel in order to allow several operating systems to run at the same
time in the same machine.

Hyperthreading > Advanced Chipset Control
Hyperthreading activates additional CPU threads that may appear as additional pro-
cessors and is used to improve CPU multi-tasking. The operating system will view
a processor with Hyperthreading enabled as two virtual processors and will spread
any tasks between them (make sure your installed operating system supports multi-
ple processors, and preferably, is optimized for this technology). After enabling/dis-
abling Hyperthreading, and saving and exiting the BIOS, the system will shut down
(press the power button to turn the system on again).

CPU C State > Advanced Chipset Control
Enable/Disable CPU C States (operating states) here.

Turbo Boost > Advanced Chipset Control
You can enable Turbo Boost to automatically run the processor core faster than the
stated frequency (within specification limits of the Thermal Design Power) for in-
creased performance.
5 - 12 Advanced Chipset Control Menu
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Phoenix SecureCore Setup Utility. This
will not affect access to the computer OS (only the Phoenix SecureCore Setup
Utility).


Security Menu

The changes you
make here affect the
access to the Setup
utility itself, and also
access to your ma-
chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in
your software OS.

Figure 5 - 5
Security Menu
Security Menu 5 - 13
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Set User Password (Security Menu)
You can set a password for user mode access to the Phoenix SecureCore Setup
Utility. This will not affect access to the computer OS, (only the Setup utility) unless
you choose to set a Password on Boot (see below). Many menu items in the Phoenix
SecureCore Setup Utility cannot be modified in user mode. You can only set the
user password after you have set the supervisor password.

Password on boot (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”. 

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.


Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
5 - 14 Security Menu
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TPM State

Change TPM State (TPM State)
This menu allows you to set the level of TPM functionality. You can enable/disable
the TPM function altogether, or clear all existing TPM information. 

Note: If you clear all TPM information it will be erased altogether and the informa-
tion will need to be reconfigured.


Password 
Protection

Note that you should set
a supervisor password
in the BIOS to protect
the TPM information
from being tampered
with by unauthorized us-
ers.

Figure 5 - 6
TPM State
TPM State 5 - 15
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If you have made any changes to the TPM State you will be asked to execute or reject
the changes made after you have saved and exited the BIOS. Highlight the required
option (it will be white), and then press Enter to save it.

Figure 5 - 7
Physical Presence 

Operations
5 - 16 TPM State
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Boot Menu

When you turn the computer on it will look for an operating system (e.g. Windows
7) from the devices listed in this menu, and in this priority order. If it cannot find
the operating system on that device, it will try to load it from the next device in the
order specified in the Boot priority order. Item specific help on the right is avail-
able to help you move devices up and down the order.

Figure 5 - 8
Boot Menu


BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages. 
Boot Menu 5 - 17
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Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

Figure 5 - 9
Exit Menu
5 - 18 Exit Menu
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Chapter 6: Upgrading The Computer

Overview
This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problems you can con-
tact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk Drive(s)
• Upgrading the Optical (CD/DVD) Device
• Upgrading the System Memory (RAM)

Please make sure that you review each procedure before you perform it.


Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Overview 6 - 1
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When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.


Power Safety Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). 

It is advisable to also re-
move your battery in or-
der to prevent
accidentally turning the
machine on. Before re-
moving the battery
disconnect the AC/DC
adapter from the com-
puter first.


Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.
6 - 2 Overview
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery. Before removing the battery disconnect the AC/
DC adapter from the computer first.

1. Turn the computer off, remove the AC/DC adapter and turn it over.
2. Loosen screws  -  and carefully lift the battery  up.
3. Remove the battery from the battery bay.


Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 1
Battery Removal

1 3 4

1

4

4

2 3
Removing the Battery 6 - 3
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Upgrading the Hard Disk Drive(s)
The hard disk drive(s) can be taken out to accommodate other 2.5" serial (SATA)
hard disk drives with a height of 9.5mm (h) (see “Storage” on page D - 3). Follow
your operating system’s installation instructions, and install all necessary drivers
and utilities (as outlined in “Drivers & Utilities” on page 4 - 1), when setting up a
new hard disk.


HDD System Warning

New HDD’s are blank. Be-
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the CD-ROMs
and FDDs required to in-
stall your operating system
and programs.
If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.
6 - 4 Upgrading the Hard Disk Drive(s)
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Removing the Hard Disk(s) from the Primary HDD Bay
1. Turn the computer off, remove the AC/DC adapter, turn it over and remove the bat-

tery.
2. Locate the hard disk bay cover and remove screws  & .
3. Remove the hard disk bay cover .


RAID Hard Disks

All hard disks in a RAID
should be identical (the
same size and brand) in
order to prevent unex-
pected system behavior.

Figure 6 - 2
Primary HDD Bay 
Cover Screws & 
Cover Removal

1 2
3

1 2

3
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4. Disconnect the HDD cable .
5. Remove screws  -  from the hard disk assembly.
6. Pull the tab  to disconnect the hard disk assembly from the connector.
7. Remove the hard disk assembly .
8. Remove the HDD board & cable .

4
5 8

9
10
11

45 6

7 8

9

11 10

Figure 6 - 3
Hard Disk Assembly 
Screws & Removal
6 - 6 Upgrading the Hard Disk Drive(s)
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9. Remove screws  -  (depending on how many hard disks you have installed in 
the assembly).

10. Remove the hard disk(s)  from the case.

Figure 6 - 4
Hard Disk(s) 

Removal

12 15

16

13

14

13

12

15

12

14

15

16 16
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11. If two hard disks are installed then an insulation plate will be installed on the upper 
hard disk.

12. Remove screws  -  and the insulation plate .
13. Reverse the process to install any new disk(s) and do not forget to install the 

insulation plate (onto the upper hard disk in the orientation illustrated below), 
screws, cables and covers (pay careful attention to the orientation of the hard disks 
in the case).

Figure 6 - 5
Upper HDD 

Insulation Plate 
Removal

17 20 21

18

19

20

17

21
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Inserting the Primary Hard Disk(s)
1. Insert the HDD(s)  into the case as illustrated (make sure the cable connec-

tors are facing towards the gap at the rear of the case, and that the upper HDD 
insulation plate is installed).

2. Insert screws  -  to secure the hard disk(s) in the case.

Figure 6 - 6
HDD Insertion & 

Screws

1

2 5

1 1

2

3

2

3

4

5

2

3

4

5
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3. Firmly insert the HDD cable  into the hard disk case  as indicated below.
4. Insert the HDD assembly into the bay by pushing it straight down (do not insert the 

assembly at an angle).
5. Firmly connect cable  and then secure the assembly with screws  - .

Figure 6 - 7
HDD Cable Insertion 
& Bay Screws/Cable 

Connection

6 7

8 9 12

6

7

8
9

11

10

12
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Removing the Hard Disk from the Secondary HDD Bay
1. Remove the battery (the Secondary hard disk bay is located under the battery).
2. Remove screws  -  from the hard disk assembly.
3. Grip the tab and slide the hard disk assembly in the direction of the arrow .
4. Lift the hard disk assembly out of the compartment.

Figure 6 - 8
Secondary HDD 

Assembly Removal

1 4
5

1 2

5

3 4
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5. Remove screws  -  from the hard disk assembly.
6. Separate the HDD  from the case .
7. Insert the replacement HDD into the case (make sure the cable connector is 

facing towards the rear of the case as illustrated below).
8. Replace screws  - .
9. Insert the HDD assembly into the bay by pushing it straight down (do not insert the 

assembly at an angle) and then slide it in the direction of arrow  to lock in place.

Figure 6 - 9
Secondary HDD 

Assembly Removal
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Upgrading the Optical (CD/DVD) Device
1. Locate the hard disk bay cover and remove screws  & .
2. Remove the hard disk bay cover .
3. Remove the screw at point , and use a screwdriver to carefully push out the 

optical device at point .
4. Reverse the process to install any new optical device.

Figure 6 - 10
Removing the CD/

DVD Device

1 2
3

4
5

1
2

3

4

5

1 2
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Upgrading the System Memory (RAM)
The computer has three memory sockets for 204 pin Small Outline Dual In-line
(SO-DIMM) DDR III (DDR3) type memory modules (see “Memory” on page D -
2). The total memory size is automatically detected by the POST routine once you
turn on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Remove screws  &  from the bottom of the computer

Figure 6 - 11
LED Module Screws

1 2

1 2
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3. Turn the computer over, open the Lid/LCD, and carefully (a cable is connected to 
the underside of the LED cover module) unsnap up the LED cover module from 
point  on the right.

4. Disconnect cable  and remove the LED cover module .

3

3

5

4

Figure 6 - 12
LED Cover Module 

Removal

Figure 6 - 13
LED Cover Module 
Cable Disconnect

4

4

5

5
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5. Remove screws  -  from the keyboard.

6. Carefully lift the keyboard up, being careful not to bend the keyboard ribbon cable.
7. Disconnect the keyboard ribbon cable  from the locking collar socket .

Figure 6 - 14
Keyboard Screws

Figure 6 - 15
Disconnect the 

Keyboard Locking 
Collar 

6 10 

76 8 9 10

11 12 

11

12
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8. Remove the keyboard .
9. Remove screws  -  from the keyboard shielding plate.

Figure 6 - 16
Keyboard Removal

Figure 6 - 17
Keyboard Shielding 

Plate Screws

13 
14 16 

13

14 15

16
Upgrading the System Memory (RAM) 6 - 17



Upgrading The Computer

6

10. Lift the keyboard shielding plate up in the direction of the arrow .
11. Remove the keyboard shielding plate .

Figure 6 - 18
Keyboard Shielding 

Plate Up

Figure 6 - 19
Keyboard Shielding 

Plate Remove

17 
18 

17

18
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12. Gently pull the two release latches (  & ) on the sides of the memory 
socket(s) in the direction indicated below.

13. The RAM module  will pop-up, and you can remove it.

14. Pull the latches to release the second module if necessary.
15. Insert a new module holding it at about a 30° angle and fit the connectors firmly 

into the memory socket.
16. The module’s pin alignment will allow it to only fit one way. Make sure the module 

is seated as far into the socket as it will go. DO NOT FORCE the module; it should 
fit without much pressure.

17. Press the module in and down towards the mainboard until the socket levers click 
into place to secure the module.

18. Replace the shielding plate (see over) screws, keyboard (reconnect the keyboard 
cable) and LED cover module (see the preceding pages).

Figure 6 - 20
RAM Module 

Removal


Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the cleanest
hands have oils which
can attract particles, and
degrade the module’s
performance.

LED Module Cable

Make sure you recon-
nect the keyboard cable
(  Figure 6 - 15). and
LED cover module cable

 (see Figure 6 - 12).
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Keyboard Shielding Plate Insertion
1. When re-inserting the keyboard shielding plate  make sure you insert it by slid-

ing it into position at an angle as illustrated by arrow  below, and press it down 
into position.

2. Secure the plate with screws  - .

Figure 6 - 21
Keyboard Shielding 

Plate Insertion
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Chapter 7: Modules

Overview
This chapter contains the information on the various modules (some of which are
optional) which may come with your computer, depending on the configuration
purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

• Setting Up SATA RAID Mode
• Wireless LAN Module
• PC Camera Module
• TV Tuner Module
• Bluetooth Module
• Security Modules (Fingerprint & TPM)
Overview 7 - 1
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Setting Up SATA RAID Mode

AHCI Mode
Advanced Host Controller Interface (AHCI) is an interface specification that allows
the storage driver to enable advanced serial ATA features such as Native Command
Queuing (for maximum hard disk efficiency and performance). AHCI mode can be
supported by one, two or three hard disks.

RAID
To configure your system in Striping (RAID 0) or Mirroring (RAID 1) modes (see
Table 7 - 1, on page 7 - 3) you will require at least two identical (see sidebar) hard
disks; to configure your system in Intel® Rapid Recover Technology (Recovery)
mode you will require two hard disks installed; to configure your system in Parity
Across Disks (RAID 5) mode you will require three hard disks installed.

Intel® Rapid Storage Technology Application
Make sure you install the Intel® Rapid Storage Technology application if you
have set up your hard disk(s) in RAID mode (see “Intel Rapid Storage Technolo-
gy” on page 7 - 8).


RAID Hard Disks

All hard disks in a RAID
should be identical (the
same size and brand) in
order to prevent unex-
pected system behavior.
7 - 2 Setting Up SATA RAID Mode
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Prepare the following before setting up your serial ATA hard disks in RAID mode:

1. The Microsoft Windows 7 OS DVD.
2. A second (identical) hard disk installed in the Primary HDD bay.

OR
A second (identical) hard disk installed in the Primary HDD bay, and a third 
(identical) hard disk in the Secondary HDD bay if required.

3. The Device Drivers & Utilities + User’s Manual disc.

RAID Level Description

RAID 0
Identical drives reading and writing data in parallel to increase performance. RAID 0 
implements a striped disk array and the data is broken into blocks and each block is 
written to a separate disk drive.

RAID 1

Identical drives in a mirrored configuration used to protect data. Should a drive that is 
part of a mirrored array fail, the mirrored drive (which contains identical data) will 
handle all the data. When a new replacement drive is installed, data to the new drive is 
rebuilt from the mirrored drive to restore fault tolerance.

Recovery
Two Identical drives copying data between a master and a recovery disk. This provides 
more control over how data is copied between the master and recovery drives, fast 
volume updates and the ability to view the data in Windows Explorer.

Table 7 - 1
RAID Levels


Array Types

A Mirrored Array
(RAID 1) provides full
data protection, as
data can simply be
copied from a healthy
disk to a replacement
for any failed disk.

A Striped Array
(RAID 0) is NOT fault-
tolerant. The failure of
one drive will result in
the loss of all data in
the array. It is de-
signed to increase disk
performance by
spreading the I/O load
across the channels
and drives.
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SATA RAID Setup Procedure (BIOS)
1. Start-up your notebook computer and press <F2> to enter the BIOS.
2. Go to the Advanced menu, select "SATA Mode Selection" and press Enter (see 

page 5 - 8).

• Select “RAID”.

3. Press Esc and go to the Boot menu.
4. Set the DVD-ROM Drive (make sure the Microsoft Windows 7 OS DVD is

inserted) as the first device in the boot order from the Boot menu (see “Boot
Menu” on page 5 - 15).

5. Select Exit Saving Changes from the Exit menu (or press F10 and Enter) and
press Enter to exit the BIOS and reboot the computer.

6. See the instructions in “RAID Setup (Intel Matrix)” on page 7 - 5.
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RAID Setup (Intel Matrix)
1. As the computer starts up press Ctrl + i to enter RAID configuration menu.

2. Select 1.Create RAID Volume and press Enter.
3. Type the RAID volume name and then press Tab or Enter to advance to the next 

field.
4. Specify (use the up and down arrow keys) the RAID level (RAID 0, RAID 1, RAID 

5 or Recovery - see Table 7 - 1, on page 7 - 3) and then press Tab or Enter to 
advance to the next field.

Figure 7 - 1
Intel(R) Rapid 

Storage Technology 
Option ROM


Recovery Level

When selecting disks for
the Recovery RAID level
you will need to use the
Tab key to select a Mas-
ter disk, and the Space
key to select a Recov-
ery disk.

You can select the syn-
chronization between
the disks to be Continu-
ous (automatic) or On
Request (manually).
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5. Press Enter and the system will select the physical disks to use.
6. Press Enter and select (if applicable) the Strip Size (best set to default).
7. Press Enter and select the Capacity size (best set to default).
8. Press Enter to select Create Volume.
9. Press Enter to create the volume, and confirm the selection by pressing Y.
10. This will now return to the main menu.

11. Select 5.Exit and press Enter, then press Y to exit the RAID configuration menu.


Recovery Level

When selecting disks for
the Recovery RAID level
you will need to use the
Tab key to select a Mas-
ter disk, and the Space
key to select a Recov-
ery disk.

You can select the syn-
chronization between
the disks to be Continu-
ous (automatic) or On
Request (manually).

Figure 7 - 2
RAID Created
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12. Make sure the Windows 7 OS DVD is in the DVD drive. and as the computer 
starts up it will automatically boot from the Windows 7 OS DVD.

13. Press Enter to continue installing the operating system as normal (see your 
Windows documentation if you need help on installing the Windows OS).

14. Install the Windows drivers from the Device Drivers & Utilities + User’s Manual 
disc as per Table 4 - 1, on page 4 - 3 (make sure you install the Intel Rapid 
Storage Technology driver - see “IRST Driver Installation” on page 7 - 8).
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Intel Rapid Storage Technology
The Intel Rapid Storage Technology application provides high-performance
SATA and SATA RAID capabilities. Install the Intel Rapid Storage Technology
application to support your RAID system or SATA drive if set up in AHCI mode
in the BIOS (see “SATA Mode (Advanced Menu)” on page 5 - 9).

IRST Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 4.Install IRST Driver > Yes.
4. Click Next > Next > Yes > Next > Next.
5. Click Finish to restart the computer (you will need to restart the system 

again after the computer has rebooted).

See the following pages for more information if you have set your hard disks up in
a RAID configuration.
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Intel® Rapid Storage Technology for RAID Systems
Intel® Rapid Storage Technology application displays status information on your
RAID configuration. Run the Intel® Rapid Storage Technology application from
the Intel item in the All Programs menu.

When the Intel® Rapid Storage Technology application is launched the system
will open the Status window. Here you can view the general health of the storage
system. Various volume creation and management options are available depending
on the system’s status.

Figure 7 - 3
Intel® Rapid 

Storage Technology
 Status
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RAID Volume Data Verification and Repair
The RAID volume data verification process identifies any inconsistencies or bad
data on a RAID 0 or RAID 1 volume. The table outlines what occurs for each RAID
level:

Replacing and Reverting Recovery and Master Volumes
If a master or recovery drive fails you will need to add a new identical drive and re-
build the recovery volume to the drive. You can also revert the master drive to the
state of the previous volume update. For details on how to do this see “Intel® Rapid
Storage Technology Help” on page 7 - 11.

See over for details on how to verify and repair RAID volume data.

RAID 
Level

Verify Verify & Repair

RAID 0 Bad blocks are identified. N/A

RAID 1

Bad blocks are identified.

Data on the mirrored drive is compared to 
data on the source drive.

Bad blocks are reassigned.

If the data on the mirrored drive does not 
match the data on the source drive, the 
data on the mirrored drive is overwritten by 
the data on the source.

RAID 5

Bad blocks are identified.

Parity is recalculated and compared to the 
stored parity for that stripe.

Bad blocks are reassigned.

If the newly calculated parity does not 
match the stored parity, the stored parity is 
overwritten with the newly calculated parity.

Table 7 - 2
RAID Verification & 

Repair Status
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Intel® Rapid Storage Technology Help
If a hard drive member of a RAID volume is reported as “Degraded” or “Failed” it
may be possible to recover the volume. If the volume cannot be restored then you
will need to recreate the RAID volume and restore the data from a back up. Click the
Help menu (or press F1) for instructions on how to recover or recreate RAID Vol-
umes.


Help

Click the Help (or
press F1) menu button
at the top of the Intel®
Rapid Storage Tech-
nology application.

Click Contents to view
the general list of sub-
jects covered, click In-
dex or Search for a
more specific help top-
ics on a particular item.

Click More help on
this page at the bot-
tom of any page for
page specific help.

Figure 7 - 4
Intel® Rapid 

Storage 
Technology

 Help
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RAID Volume Data Verification and Repair
The RAID volume data verification process identifies any inconsistencies or bad
data on a RAID 0 or RAID 1 volume. The table outlines what occurs for each RAID
level:

Replacing and Reverting Recovery and Master Volumes
If a master or recovery drive fails you will need to add a new identical drive and re-
build the recovery volume to the drive. You can also revert the master drive to the
state of the previous volume update. For details on how to do this see the help file
“Intel® Rapid Storage Technology Help” on page 7 - 11. See over for details on
how to verify and repair RAID volume data. Verification will identify and repair
data inconsistencies on the volume.

RAID Level Verify Verify & Repair

RAID 0 Bad blocks are identified. N/A

RAID 1

Bad blocks are identified.

Data on the mirrored drive is compared 
to data on the source drive.

Bad blocks are reassigned.

If the data on the mirrored drive does not 
match the data on the source drive, the 
data on the mirrored drive is overwritten by 
the data on the source.

RAID 5

Bad blocks are identified.

Parity is recalculated and compared to 
the stored parity for that stripe.

Bad blocks are reassigned.

If the newly calculated parity does not 
match the stored parity, the stored parity is 
overwritten with the newly calculated parity.

Table 7 - 3
RAID Verification & 

Repair Status
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Verifying and Repairing RAID Volume Data
1. Before verifying the volume data you will need to initialize the volume.
2. Run the Intel® Rapid Storage Technology application from the Intel item in the 

Programs/All Programs menu.
3. Click Manage and click Advanced.
4. Click Initialize and click Yes (button) to begin the process.
5. The completion percentage will be listed under Status.

Figure 7 - 5
Intel® Rapid 

Storage 
Technology

 Initialize
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6. Click Advanced and click Verify, then click Verify (button) to begin the process.
7. The completion percentage will be listed under Status (verifying and repairing).

Figure 7 - 6
Intel® Rapid 

Storage 
Technology

 Verify
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Wireless LAN Module
If you have included an Intel® Wireless LAN module or 3rd Party 802.11b/g/n
WLAN module in your purchase option, make sure that the Wireless LAN module
is on before installing the driver.

Use the Fn + F11 key combination or Touch Sensor Instant Key to toggle power
to the Wireless LAN module. When the WLAN module is powered on, the touch sen-
sor  LED will be highlighted and the indicator  will briefly be displayed.
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.
The operating system is the default setting for Wireless LAN control in Windows 7.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Blue-
tooth Combo module.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination/Touch Sensor In-
stant key to toggle power to
the WLAN module, and
check the LED to see if the
module is powered on or
not (see Table 1 - 4, on
page 1 - 10/ Table 1 - 3, on
page 1 - 8).
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Intel® Wi-Fi Link Series Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.

1. Make sure the module is powered on, then insert the Device Drivers & Util-
ities + User’s Manual disc into the CD/DVD drive. 

2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Next > Finish.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see overleaf).

802.11b/g/n Driver Installation
1. Make sure the module is powered on, then insert the Device Drivers & Util-

ities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish to restart the computer.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows 7 (see overleaf).


Intel(R) PROSet/ 

Wireless

Access the Intel PRO-
Set Wireless tools (Sta-
tistics and Diagnostic
tools) from the Start
menu (Start > Pro-
grams/All Programs >
Intel PROSet Wire-
less). These tools pro-
vide diagnostic and
statistical information
only (use the WLAN
control in Windows to
connect to a WLAN ac-
cess point).
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Connecting to a Wireless Network in Windows 7
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then double-click an access point to con-
nect to or click to Open Network and Sharing Center if you do not see a network 
you want to connect to in the taskbar menu (a list of options will appear allowing 
setting changes, and creating a new network).


Network and 

Sharing Center

You can also use the Net-
work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 - 7
Click Taskbar Icon 
Menu & Network 

and Sharing Center
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2. You may need to enter a security key for any access point to which you are trying 
to connect.

3. Click to select a network location (e.g. Home, Work or Public).
4. Click “View or change settings in Network and Sharing Center” to access 

further options for the connection.

Figure 7 - 8
Network Location 

Set
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5. Click the taskbar icon  to see any currently connected networks.
6. To disconnect from the wireless network you can click the taskbar wireless icon ,

click the active connection and then click Disconnect (button).


Security Enabled 
Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure
networks may allow unau-
thorized access to your
computer, documents,
websites and files etc.

Figure 7 - 9
Click Taskbar Icon 

Menu - Disconnect
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Intel® My WiFi Configuration
Intel® My WiFi Technology uses your WLAN (for Intel WLAN modules only)
module to allow you to connect up to eight other WiFi enabled devices (e.g. digital
cameras, other computers, cell phones, handheld devices etc.) to your computer
(similar to Bluetooth), while still connecting to the Internet through your WiFi wire-
less connection. Intel® My WiFi Technology offers greater range and speed than
other personal area networks, and does not require an access point.


Intel® My WiFi Help

To get help on Intel®
My WiFi configuration
and settings, access the
Intel® My WiFi Utility
from the Start menu
(Start > Programs/All
Programs > Intel PRO-
Set Wireless > Intel My
WiFi Technology), or by
clicking the taskbar icon

. Click the Help icon
 and select a

help topic from the Con-
tents menu.
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Intel® My WiFi Configuration
You can configure the My WiFi settings as follows.

1. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All 
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by double-
clicking the taskbar icon .

2. Click Enable  (on the first run of the program there will be no connected 
devices listed).

Figure 7 - 10
Intel® My WiFi 

Utility
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3. Click Start and click Control Panel.
4. Click Network and Sharing Center (Network and Internet). 
5. Click Change adapter settings. 

Figure 7 - 11
Network and 

Sharing Center

Click Change 
adapter settings 
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6. Right-click Wireless Network Connection and select Properties.

Figure 7 - 12
Network 

Connections

Right-click Wireless Network
Connection and select Proper-
ties. 
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7. Click Sharing (tab) and select “Allow other network users to connect through 
this computer’s Internet connection”.

8. Select Wireless Network Connection under Home networking connection.
9. Click OK.

Figure 7 - 13
Wireless Network 

Connection 
Properties - 

Sharing

Click “Allow other network
users to connect through
this computer’s Internet
connection”.

Select Wireless Network
Connection.
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10. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All 
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by double-
clicking the taskbar icon .

11. Click Profiles .

Figure 7 - 14
Intel® My WiFi 
Utility - Profiles
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12. Click Profiles, click Intel Wireless PAN and click Edit or New (Note that all 
preset settings may not be editable - see sidebar).

13. You can change the Profile Name and Network Name to your personal 
preferences in General (tab).

Figure 7 - 15
Profiles


Profile Settings

Profiles that are preset
may not be fully edit-
able. To edit all the
profile settings, click
New to create a new
profile and adjust the
settings to your prefer-
ences.

Figure 7 - 16
Intel® My WiFi 

Profile Settings - 
General


Profile and Network Names

The Profile Name is the name as dis-
played on your computer in the Net-
work Connections control panel
(see Figure 7 - 17 on page 7 - 27).

The Network Name (SSID) is the
name the devices see when they try
to connect to your computer.
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14. Click Security (tab).
15. Change the Security Type to WEP and the Encryption Type to 64bit.
16. Enter a password (8 characters long) in the Password box. 

Figure 7 - 17
Intel® My WiFi 

Profile Settings - 
Security
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17. Click Sharing (tab).
18. It is recommended that the Filter Network Traffic and DHCP and DNS Server 

are Disabled. 

Figure 7 - 18
Intel® My WiFi 

Profile Settings - 
Sharing
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19. Click Advanced (tab).
20. It is recommended that the Default Channel is set to Channel 1, 6 or 11.
21. Click OK to save the settings. 

Figure 7 - 19
Intel® My WiFi 

Profile Settings - 
Advanced
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22. Double-click Wireless Network Connection in Network Connections.
23. Click Details to display the Network Connection Details.

Figure 7 - 20
Wireless Network 

Connection Details
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24. Access the Intel® My WiFi Utility from the Start menu (Start > Programs/All 
Programs > Intel PROSet Wireless > Intel My WiFi Technology), or by clicking 
the taskbar icon .

25. To add a new device follow the instructions in the devices’ user guide for 
connecting to a WiFi network.

26. Click Add New Device in Intel® My WiFi Utility to confirm the security settings 
detail.

Figure 7 - 21
Intel® My WiFi 

Utility 
(Add New Device)
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Windows Mobility Center
The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click Start, and click Control Panel (or point to Settings and click Control 
Panel).

2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon  to access the network 

menu.

Figure 7 - 22
Windows Mobility 

Center
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PC Camera Module
Before installing the driver, make sure the PC Camera is on. Use the Fn + F10 key
combination or Touch Sensor Instant Key to toggle power to the to the PC Camera
module. When the PC Camera module is powered on, the touch sensor LED will be
highlighted and the indicator  will briefly be displayed. Make sure you install
the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

There are a number of different camera modules available with this computer model
series. You will have the appropriate application installed for your camera (note that
some versions of the camera application do not support the zoom function). Make
sure you access the application via the desktop shortcut.


Latest PC Camera 
Driver Information

Check the Device Drivers
& Utilities + User’s Manu-
al disc and any accompa-
nying insert pages, for the
latest updated information
on the PC Camera driver,
which may override the in-
formation provided here.

PC Camera Display

The PC Camera applica-
tion software needs to be
run while the default note-
book LCD is the selected
display device.

After a camera picture is
obtained on the default
notebook LCD, you may
then use the Fn + F7 to tog-
gle through the display
modes (give the screen
time to refresh).


PC Camera Application and Power-Saving States

If the computer enters Sleep or Hibernate mode while running the camera application, the
program will stop running, and will need to be restarted when the system resumes from the
power-saving state.
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PC Camera Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 2.Install WebCam Driver > Yes.
4. Choose the language you prefer and click Next > Next > Finish.
5. Run the camera application program from the desktop shortcut (if the hard-

ware is turned off use the Fn + F10 key combination to turn it on again).
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PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is 

not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to 

the level required.
7. Click OK and close the control panels.
8. Run the camera application program from the desktop shortcut.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should 

have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick 

alongside it).
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Figure 7 - 23
Audio Setup for PC 

Camera

Right-click
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Camera Application
The camera application is a video viewer for general purpose video viewing and test-
ing, and for capturing video files to .avi format.

1. Run the camera application from the desktop shortcut (it is recommended that you 
set the capture file before the capture process - see below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page 7 - 35) and select Start Capture.

3. Click OK/Yes (the file location will be displayed in the pop-up box) to start 
capturing the video, and press Esc to stop the capture (you can view the file using 
the Windows Media Player).

Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and location before capture (this will help avoid ac-
cidentally overwriting files). Set the name and location then click Open, then set the
"Capture file size:" and click OK. You can then start the capture process as on the
previous page.

Note the important information in “Reducing Video File Size” on page 7 - 38 in
order to save file space, and help prevent system problems.


Pre-Allocating File 

Size/Space

You may pre-allocate the
file size (File > Allocate
File Size/Space) for the
capture file in the camera
program (you may need
to set a folder location
first).

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

See also “Reducing Vid-
eo File Size” on page 7 -
38.
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Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows system requires a minimum of 15GB of free space on the C:
drive system partition. In order to prevent system problems it is recommended that
you save the captured video file to a location other than the C: drive (see “Set Cap-
ture File” on page 7 - 37), limit the file size of the captured video (see “Pre-Allo-
cating File Size/Space” on page 7 - 37) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the camera application program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to 

reduce the captured file size.
4. Click OK.
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Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to
adjust the setting in the Video Capture Filter options.

1. Run the camera application from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Frequency (Anti Flicker).


Latest PC Camera 
Driver Information

Check the Device Driv-
ers & Utilities + User’s
Manual disc, and any
accompanying insert
pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here, including the fig-
ures pictured here.

Figure 7 - 24
Video Capture Filter
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Taking Still Pictures
The camera application allows you to take still pictures.

1. Run the camera application from the desktop shortcut.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder  on the 

desktop.


Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.
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TV Tuner Module
If your purchase configuration includes the optional Hybrid (Analog & Digital)
USB Mini-Card TV Tuner module, you will be supplied with a remote control unit
and appropriate antenna and fittings for the module. Software support for the TV
Tuner module is provided by Windows Media Center in Windows 7 (not included
in Starter or Home Basic versions). A driver is provided on the Device Drivers &
Utilities + User’s Manual disc for the remote control supplied with the TV Tuner.

The optional TV Tuner allows you to watch TV, play music CDs, video conference
and capture still images and video on your PC.

The Cable (CATV) antenna will only be enabled when a TV Tuner module is
installed. Make sure you connect the TV antenna.


TV Antenna

The TV antenna sup-
plied with any TV Tuner
module is intended for
indoor use only. Please
do not use your TV Tun-
er module outdoors.

TV Tuner Remote

Point the remote at the
consumer IR transceiv-
er to change channels
etc.

Figure 7 - 25
TV Tuner Ports/

Jacks

1. Consumer Infra-
red Transceiver

2. CATV Antenna 
Jack2

1
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Consumer Infrared Driver
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 3.Install CIR Driver > Yes.
4. Choose the language you prefer and click Next > Next.
5. Click Finish to restart the computer.

Windows Media Center
1. This TV Tuner module is fully supported by Windows Media Center in 

Windows 7 (not included in Starter or Home Basic versions).
2. Run Windows Media Center directly from the Start menu (Start > Pro-

grams > Windows Media Center).
3. Windows Help and Support provides information on the Windows Media 

Center functions. Click Start  and select Help and Support, and then 
type “Media Center” in the Search Help box and click the magnifying 
glass icon  to bring up the results.


TV Tuner Module 

Support

Note that the TV Tuner
module options in Win-
dows 7 is supported by
the Windows Media
Center software which
comes built-in to all the
Windows 7 versions
except Starter and
Home Basic. 

If your purchase in-
cludes a TV Tuner op-
tion, and you are re-
configuring your system
for a different system,
you should install any
Windows 7 version ex-
cept Starter and Home
Basic.
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Digital TV Broadcast Signal
The antenna is the most crucial factor in receiving a clear digital terrestrial TV
broadcast signal. The passive antenna provided should provide a clear signal when
placed beside a window. If the signal is not clear then you can purchase an active
antenna (it should also be placed beside a window) to improve the signal. You
should also check with any related government website which provides information
on digital terrestrial TV coverage for your area. Note that (unlike standard analog
TV) if the digital signal is weak then no picture will appear on the TV at all.

TV Recording and Power Plans
If you intend to use the optional TV Tuner to record live TV, then go to the Power
Options control panel and create a power plan (see “Power Plans” on page 3 - 4)
to prevent the power saving options from adjusting the computer’s performance lev-
el.

Remote Control Unit
The remote control unit allows you to remotely start and send the system into a pow-
er saving state, to run Windows Media Center and to navigate the Media Center
menus etc. The remote control unit also gives full control over all TV and video
functions.


CATV Cable Safety

Make sure that your
CATV system installer
has connected the Co-
axial cable shield to the
grounding system of the
building, as close to the
point of cable entry as
practical.

This reminder is provid-
ed to call the CATV sys-
tem installer’s attention
to Article 820-93 of the
NEC (Section 54, Part I
of the Canadian Electri-
cal Code).
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Bluetooth Module
The optional Bluetooth module allows you to connect your computer to Bluetooth
enabled devices such as other computers, desktop computers, mobile phones, print-
ers, digital cameras, PDAs, headsets etc. using a short-range radio frequency.

If your purchase option includes the Combination Wireless LAN & V3.0 Blue-
tooth module (either Intel® Centrino Advanced-N 6230 or 3rd Party) then in-
stall the driver as instructed below:

• For 3rd party Bluetooth modules see the installation procedure see “3rd Party 
Bluetooth Combo Driver Installation” on page 7 - 46 and “3rd Party Blue-
tooth & WLAN Combo Settings” on page 7 - 47.

• For Intel Bluetooth modules see the installation procedure see “Intel Blue-
tooth Combo Driver Installation” on page 7 - 54 and “Bluetooth Configura-
tion in Windows 7” on page 7 - 55.

If your purchase option includes the standalone V2.1 Bluetooth module then no
driver is required and you can configure the settings as per the instructions in “Blue-
tooth Configuration in Windows 7” on page 7 - 55.

Use the Fn + F12 key combination or Touch Sensor Instant Key to toggle power
to the Bluetooth module. When the Bluetooth module is powered on, the touch sen-
sor  LED will be highlighted and the indicator  will briefly be displayed.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED to see if the
module is powered on or
not (see Table 1 - 4, on
page 1 - 10/ Table 1 - 3, on
page 1 - 8).

Note that you need to
install both the WLAN
& Bluetooth drivers
for the WLAN & Blue-
tooth Combo module.
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Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in
one direction only (simultaneous data transfer is not supported). Therefore if you are copying a
file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Blue-
tooth enabled device to your computer until the file transfer process from the computer has been com-
pleted.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use
the key combination (Fn + F12) to power on the Bluetooth module after the computer resumes from
Sleep.
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3rd Party Bluetooth Combo Driver Installation
Note this driver is required only for the combo Bluetooth and WLAN module only.

1. Before installing the driver make sure the Bluetooth module is powered 
on (use Fn + F12 key combination), then insert the Device Drivers & Utili-
ties + User’s Manual disc into the CD/DVD drive. If a Found New Hard-
ware window appears, click Cancel in all windows that appear, and then 
proceed to install the driver as below.

2. Click Option Drivers (button).
3. Click 6.Install Combo BT Driver > Yes.
4. Choose the language you prefer and click OK.
5. Click Next.
6. Click the button to accept the license and click Next.
7. Click Next > (select if you want to create an icon to appear on the desktop) 

Next > Install.
8. Click Finish.
9. The My Bluetooth icon  will appear on the desktop and the Bluetooth 

item will be installed in the Programs/All Programs menu.
10. See overleaf for information on Bluetooth networking.


High Speed Bluetooth 

Data Transfer

The Combination Wire-
less LAN & V3.0 Blue-
tooth module supports
high speed (V3.0) data
transfer. However to
achieve such transfer
speeds, both devices
must support high
speed data transfer.

To obtain high speed
(V3.0) data transfer
make sure that both the
WLAN and Bluetooth
modules are powered
on.

Check your Bluetooth
compatible device’s doc-
umentation to confirm it
supports high speed data
transfer.
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3rd Party Bluetooth & WLAN Combo Settings
This information applies to the combo Bluetooth and WLAN module only.

1. Make sure the Bluetooth module is powered on.
2. Double-click the My Bluetooth application on the desktop (or access Bluetooth 

from the Programs/All Programs menu).
3. Click My Bluetooth Settings (menu heading).


Bluetooth Module & 

Resuming From Sleep 
Mode

The Bluetooth module’s de-
fault state will be off after re-
suming from the Sleep
power-saving state. Use the
key combination (Fn + F12)
to power on the Bluetooth
module after the computer
resumes from Sleep.

Figure 7 - 26
My Bluetooth 

Settings
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4. Click General Settings  to change the computer name that other Bluetooth 
devices will see, and click the tickbox to Allow Bluetooth devices to find this 
computer

5. Click OK to confirm the settings.

Figure 7 - 27
General Settings
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6. Click File Transfer Settings  to Enable sharing of my files with other 
Bluetooth devices.

7. Click OK to confirm the settings.

Figure 7 - 28
File Transfer 

Settings
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Bluetooth Networking Setup
This information applies to the combo Bluetooth and WLAN module only.

1. Make sure the Bluetooth module is powered on.
2. Double-click the My Bluetooth application on the desktop (or access it from the 

Programs/All Programs menu).
3. Click My Bluetooth Settings (see Figure 7 - 26 on page 7 - 47).

4. Click Network Settings (make sure the Bluetooth module is powered on.
5. Click Enable Bluetooth Network and click OK.
6. A message will appear in the notification area to confirm that the network driver 

has been installed.

Figure 7 - 29
Network Settings
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Bluetooth & WLAN Combo Module Configuration
Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the Fn + F12 key combination to power on the Bluetooth module.

To Add a Bluetooth Device
1. Double-click the My Bluetooth application on the desktop (or access it from the 

Programs/All Programs menu).
2. Double-click the device you want to pair with the computer (if no devices appear 

press F5 or click the Refresh button to search for devices).


Bluetooth Module & 

Resuming From Sleep 
Mode

The Bluetooth module’s de-
fault state will be off after re-
suming from the Sleep
power-saving state. Use the
key combination (Fn + F12)
to power on the Bluetooth
module after the computer
resumes from Sleep.

Figure 7 - 30
My Bluetooth 

Devices
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3. You will then be presented with a menu of options to select from.

4. Click the appropriate button to connect to the device.

Figure 7 - 31
Bluetooth Device 

Options
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5. You may need to allow the connection from your device, and you will then need to 
provide a passcode from the device.

6. You can then enter the passcode on the computer and click OK to establish the 
connection.

Figure 7 - 32
Bluetooth Pairing 

Code & Connection 
Established
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Intel Bluetooth Combo Driver Installation
Note this driver is required only for the Intel combo Bluetooth and WLAN module
only.

1. Before installing the driver make sure the Bluetooth module is powered 
on (use Fn + F12 key combination), then insert the Device Drivers & Utili-
ties + User’s Manual disc into the CD/DVD drive. If a Found New Hard-
ware window appears, click Cancel in all windows that appear, and then 
proceed to install the driver as below.

2. Click Option Drivers (button).
3. Click 4.Install Combo BT Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Finish.
7. See over for configuration instructions.

Note that, at the time of going to press, Intel® Centrino Advanced 6230 WLAN &
Bluetooth V3.0+HS combo modules use the standard Bluetooth configuration in
Windows 7 (see “Bluetooth Configuration in Windows 7” on page 7 - 55). Do not
use the Bluetooth & WLAN Combo settings information outlined from page 7 - 47
to page 7 - 53. See also “Intel® WLAN & Bluetooth V3.0+HS Combo Modules”
on page 8 - 19.


High Speed Bluetooth 

Data Transfer

The Combination Wire-
less LAN & V3.0 Blue-
tooth module supports
high speed (V3.0) data
transfer. However to
achieve such transfer
speeds, both devices
must support high
speed data transfer.

To obtain high speed
(V3.0) data transfer
make sure that both the
WLAN and Bluetooth
modules are powered
on.

Check your Bluetooth
compatible device’s doc-
umentation to confirm it
supports high speed data
transfer.
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Bluetooth Configuration in Windows 7

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the Fn + F12 key combination to power on the Bluetooth module. 
2. A Bluetooth icon  will appear in the taskbar.
3. You can then do any of the following to access the Bluetooth Devices control

panel.

• Double-click the taskbar icon  to access the Bluetooth Devices control panel.

• Click/Right-click the taskbar icon  and choose an option from the menu.


Add a Device

Click Start, and click
Control Panel and then
click Devices and
Printers (Hardware
and Sound). Click Add
a device to search for
any available Bluetooth
devices.

If you are experiencing
problems connecting to
some Bluetooth devices
see “” on page 8 - 14.

Figure 7 - 33
Bluetooth Devices & 

Click Icon MenuAdd a device

Right-Click Taskbar Icon 
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To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel and click Add a device.
2. Double-click the device you want to pair with the computer.

3. On first connection the computer will provide you with a pairing code to be entered 
onto the device.


Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure 7 - 34
Add a Device
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4. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

5. Windows will check to see if any drivers are required to complete the pairing. 
6. Follow any on-screen instructions on the computer if device drivers are required to

be installed.
7. Click Close.

Figure 7 - 35
Pairing Code 

Example

Figure 7 - 36
Pairing Complete & 
Bluetooth Device 

Enabled


Pairing Codes

The example outlined here shows a connection to
a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
code is correct on both devices. Follow the on-
screen instructions to complete the pairing.
Bluetooth Module 7 - 57



Modules

7

To Change Settings for the Bluetooth Device
1. Click the taskbar icon and select Show Bluetooth Devices.
2. Right-click on the device you want to change and click Properties to:

• Change the name of the device (click Bluetooth, type a new name and click OK).
• Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Click the taskbar icon and select Open Settings.
2. Click Options, and make sure that Allow Bluetooth devices to find this 

computer check box (Discovery) has a tick inside it.
3. Make sure that the Alert me when a new Bluetooth device wants to connect 

check box (Connections) has a tick inside it, if you want to be notified when a 
Bluetooth device wants to connect.


Bluetooth Help

To get help on Bluetooth
configuration and set-
tings, select Help and
Support from the Start
menu. Type Bluetooth in
the Search Help box, and
select an item from the re-
turned search results to
get more information.

Figure 7 - 37
Bluetooth Settings - 

Options
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Security Modules (Fingerprint & TPM)
The encrypted channel between the Trusted Platform Module security chip and
the fingerprint reader with Protector Suite Software provides a high level of se-
curity for your computer. A further level of security and control is provided in the
BIOS (see “Security Menu” on page 5 - 13 and “Boot Menu” on page 5 - 15).

The fingerprint reader and Protector Suite Software allow you to:

• Access or Lock your computer
• Protect sensitive files
• Display and file your favorite web pages
• Fill in frequently used dialogs
• Run your favorite applications

The TPM security chip allows you to create and manage digital certificates for user
and platform authentication. This type of security is usually administered within
large enterprises and organizations, and therefore requires implementation by a sys-
tem administrator before users can access security features.


Password Warning

If you set passwords for
any of the security mod-
ules, NEVER forget your
password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
Security Modules (Fingerprint & TPM) 7 - 59



Modules

7

Fingerprint Reader Module
If you have included the fingerprint reader in your purchase option you will need to
install the driver as per the instructions below. 

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the
fingerprint tutorial (see Figure 7 - 38 on page 7 - 61).

Fingerprint Reader Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive. 
2. Click Option Drivers.
3. Click 7.Install FingerPrint Driver > Yes.
4. Click Next > Next > Next.
5. Click Finish > Yes to restart the computer.
6. Click the tray icon , scan a finger or click Start > Programs/All Pro-

grams > Protector Suite > Control Center and then begin the enrollment 
process (see over).


Password Warning

If you set passwords for
any of the security mod-
ules, NEVER forget your
password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
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User Enrollment
1. Click Start > Programs/All Programs > Protector Suite > Control Center, or 

double click the taskbar icon  (click Initialize).
2. On the first run of the program you will be asked to click the Accept button to 

accept the license.
3. If you have not set a Windows password you will be prompted to do so (note: If 

you have not set a password Protector Suite cannot secure access to your 
computer).

4. Click Submit when you have entered password.
5. You will then be prompted to enroll your fingerprints (you can click Tutorial to get 

help with fingerprint enrollment at any time).


Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure 7 - 38
Fingerprint 
Enrollment

Tutorial
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6. Click the button above any of the fingers to begin the enrollment process for that 
finger.

7. Swipe the finger until the progress bar reaches 100% to enroll that finger.

8. Close the Protector Suite 2009 window.


Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure 7 - 39
Fingerprint 
Enrollment 
Progress
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9. Right-click the taskbar icon  and select Start Control Center (and then swipe a 
finger) to allow you to Edit Fingerprints, register Applications, edit Settings and 
access the Help menu etc. You can also run the Control Center etc. from the 
Protector Suite item in the Programs/All Programs menu

10. Click “Help” to get more information on any topic.
11. You can also run the Tutorial, or Product Tour video to get more information.

12. If you swipe your finger over the reader at any time you can access the Biomenu 
to lock the computer, register websites, access the Personal Safe, open the 
Control Center and access the Help menu.

Help

Figure 7 - 40
Control Center & 

Biomenu 
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Fingerprint Control Center Features

Application Launcher
The Application Launcher allows you to register applications to be launched when
assigned to a particular finger. Simply copy the application icon on to one of the reg-
istered fingers and ten click OK to close the application window. Once registered the
application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other set-
tings for web sites etc. 

Personal Safe
The Personal Safe is an encrypted area assigned on your hard drive that allows you
to store files and folders to be protected by fingerprint protection.


Help 

For more information on
these and other features
simply access “Help” in
the Fingerprint Control
Center and select the
item from the menu on
the left.
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Trusted Platform Module
Before setting up the TPM functions you must initialize the security platform.

Enabling & Activating TPM
1. Restart the computer.
2. Enter the PhoenixBIOS Setup Utility by pressing F2 during the POST.
3. Use the arrow keys to select the TPM State menu.
4. Select Change TPM State, and set the item to Enable & Activate.

Figure 7 - 41
TPM State

(Enable & Activate)
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5. Press F10 to save the changed BIOS information, exit the BIOS and restart the 
computer.

6. If you make any changes to the TPM State you will be asked to Execute/Reject 
the change after restart.

7. You can now install the TPM driver (see “Trusted Platform Module (TPM) 
Driver Installation” on page 7 - 67) and then initialize the TPM.

Figure 7 - 42
Physical Presence 

Operations
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Trusted Platform Module (TPM) Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 5.Install TPM Driver > Yes.
4. Click Install > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Next > Install.
7. Click Finish > Yes to restart the computer.

Initializing TPM
1. Run the application from the Infineon Security Platform Solution > Manage 

Security Platform item in the Start > Programs/All Programs menu.
2. Click User Settings (tab) and click Yes, or right-click the icon  in the 

notification area of the taskbar, and select Security Platform Initialization (or 
click the Security Platform State taskbar bubble).

3. The Quick Initialization method will automatically be selected for you (if you need 
to use advanced settings provided by your network administrator then select 
Advanced Initialization).

4. You will need to use a removable media (e.g. a USB Flash Drive) to store 
passwords and data (keep the media in a safe place until required).
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5. Select the drive you want to use from the drop-down menu and click Next.

Figure 7 - 43
Security Platform 
Quick Initialization 

Wizard
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6. Choose the Security Platform Features you want to use by clicking the 
appropriate tickbox.

7. Enter a Basic User Password (and re-type to confirm it) and click Next.

8. Click Next to confirm the settings.
9. The computer will then initialize the settings.
10. Click Finish.
11. Click the tabs and control panels to adjust the settings.
12. Double-click the taskbar icon  to access the Infineon Security Platform 

Settings Tool, or right-click the taskbar icon  and select a menu item.


Help

Right-click the icon  in
the notification area of the
taskbar  to bring up the menu
to select Help or How to use
the Security Platform Fea-
tures.

You can also click the Help
button in any of the Infineon
Security Platform Settings
Tool tabs to bring up specific
help topics on each tab.

Figure 7 - 44
Settings
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Infineon Security Platform Settings Tool
The Infineon Security Platform Settings Tool allows you to manage and check the
TPM state, manage your password information, and to backup and restore the TPM
data. As TPM is usually administered within large enterprises and organizations,
your system administrator will need to assist you in managing the information here.


Menus

Note that not all the
menus pictured here will
be available for access.
The menu items that ap-
pear will be dependent on
your configuration set-
tings etc. (see the Help
file for full details). 

Figure 7 - 45
Infineon Security 
Platform Settings 

Tool
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User Settings
This page allows the settings to be configured for the currently logged in Infineon
Security Platform user including the ability to change the password, configure se-
cure e-mail, file and folder encryption and Enhanced Authentication. You can also
import or delete certificates protected by the security platform.

Figure 7 - 46
Infineon Security 
Platform Settings 

Tool (User Settings)
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Backup
Here you can configure backup and restore operations. Backup files contain the
computer identification and user identification information which is used to match
the machine name and user name with the current machine and user during restora-
tion.

Figure 7 - 47
Infineon Security 
Platform Settings 

Tool (Backup)
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Migration
The Migration tab is used to help securely transfer keys and certificates from one
platform to another.

Figure 7 - 48
Infineon Security 
Platform Settings 
Tool (Migration)
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Password Reset
Use Password Reset to reset basic user passwords when required.

Figure 7 - 49
Infineon Security 
Platform Settings 

Tool 
(Password Reset)
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BitLocker
BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt
data on the disk and is done via the Microsoft BitLocker Control Panel Applet.
Click Configure and select a drive to be encrypted and then follow the Wizard to
begin the encryption process.

Figure 7 - 50
Infineon Security 
Platform Settings 

Tool 
(BitLocker)
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Access the Microsoft BitLocker Drive Encryption control panel applet from the
Windows control panel (System and Security).

Figure 7 - 51
BitLocker Drive 

Encryption
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Advanced
Configure all the Security Platform owner and policy settings from the Advanced
tab. The settings that can be changed are for the local computer only.

Figure 7 - 52
Infineon Security 
Platform Settings 

Tool 
(Advanced)
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Chapter 8: Troubleshooting

Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
Overview 8 - 1
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Power Indicators (see “LED Indicators” on page 1 - 7) 
to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Configuring the Power Buttons” on page 3 - 8), the Fn + F4 key combi-
nation, or power button to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness (see Table 1 - 4, on page 1 - 10).

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive 
when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the 
disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Boot password for the SCU (see “Security Menu” on page 5 - 13).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc. (even if just brief 
notes).


Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what 
you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need 
to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are 
usually available to download from vendor’s websites).

• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.
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• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and 
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
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Problems & Possible Solutions

Problem Possible Cause - Solution

You turned the power on
but it doesn’t work.

Battery missing / incorrectly installed. Check the battery bay, make sure the battery is present and
seated properly (the design of the battery only allows it to go in one way). Make sure there’s
nothing interfering with the battery contacts.

The Battery LED power
indicator , is blinking
orange.

Low Battery. Plug in the AC power source. If the computer doesn’t start up immediately, turn it off
then on again.

You are losing battery
power too quickly.

The system is using too much power. If your OS has a Power Options scheme (see “Power
Plans” on page 3 - 4) check its settings. You may also be using an ExpressCard device/USB
device/external device that is drawing a lot of power.

You are attempting to run an SLI configuration on battery power. Due to the high power and
system demands created by enabling SLI Configuration, you should not enable SLI
configuration if your computer is powered by battery only.

Actual battery operating
time is shorter than
expected.

The battery has not been fully discharged before being recharged. Make sure the battery is fully
discharged and recharge it completely before reusing (see “Battery Information” on page 3 -
10).

Check the settings of any active power plan (see “Power Plans” on page 3 - 4).

A peripheral device/USB device is consuming a lot of power. Turn off/remove the unused device
to save power.
Problems & Possible Solutions 8 - 7
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The computer feels too
hot.

Make sure the computer is properly ventilated and the vents/fan intakes are not blocked. If this
doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the
computer isn’t sitting on a thermal surface (see “Overheating” on page 1 - 15). Make sure
you’re using the correct adapter. 

Make sure that your notebook is completely powered off before putting it into a travel bag (or any
such container). Putting a notebook which is powered on in a travel bag may cause the vents/fan
intakes to be blocked.

Nothing appears on
screen.

The system is in a power saving mode. Toggle the Fn + F4 (see “Configuring the Power
Buttons” on page 3 - 8).
\

The screen controls need to be adjusted. Toggle the screen control Fn + F8/F9 key combinations.
If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should
also check the monitor’s own brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key Fn + F7 combination. If
an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on
the external monitor I
have plugged in and
powered on.

You haven’t installed the video driver and configured it appropriately from the Control Panel. See
“NVIDIA Video Driver Controls” on page B - 1 for instructions on installing and configuring the
video driver.

Problem Possible Cause - Solution
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You forget the boot
password.

If you forget the password, you may have to discharge the battery of the CMOS. Contact your
service representative for help.

The sound cannot be
heard or the volume is
very low.

The volume might be set too low. Check the volume control in the Volume Control Panel in the
Windows taskbar, use the key combination Fn + F5 and F6 or move your finger slowly along the
volume control slider to adjust the system volume (see “Audio Features” on page 2 - 11/
“Touch Sensor Instant Keys” on page 1 - 8) to adjust.

The compact disc
cannot be read.

The compact disc is dirty. Clean it with a CD-ROM cleaner kit.

The compact disc tray
will not open when there
is a disc in the tray.

The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject
hole (see “Loading Discs” on page 2 - 3).

The DVD regional
codes can no longer be
changed.

The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5.

Problem Possible Cause - Solution


Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
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The TouchPad doesn’t
work.

The Touchpad has been disabled. Press the Touchpad toggle (Fn + F1) key combination (make
sure you have installed the Touchpad driver.

The system freezes or
the screen goes dark.

The system’s power saving features have timed-out. Use the AC/DC adapter, press a key on the
keyboard, or press the sleep (Fn + F4) key combination, or press the power button if no LEDs are
lit.

The system never goes
into a power saving
mode.

Power Options features are not enabled. Go to the Windows Power Options menu and enable
the features you prefer (see “Power-Saving States” on page 3 - 6). Make sure you have
enabled Hibernate mode from the control panel.

The Wireless LAN/
Bluetooth/PC Camera
modules cannot be
detected.

The modules are off. Check the appropriate LED indicator to see if the modules are on or off (see
“Touch Sensor Instant Keys” on page 1 - 8). If the LED indicator is not illuminated, then press
the appropriate touch sensor instant key/function key combination in order to enable the
modules.

The Wireless LAN/
Bluetooth/PC Camera
modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have installed the driver
for the appropriate module (see the instructions in Chapter 7 “Modules” for the appropriate
module).

Problem Possible Cause - Solution
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When a DVD is played in
Windows Media Player/
Media Center, the audio
track in other languages
(commentaries etc.) is
not clear if connected to
the S/PDIF-Out Jack.

This is an issue with Windows Media Player/Media Center and audio output through the S/PDIF-
Out Jack. We recommend that you use the Power DVD application to play DVDs.

Nothing appears on the
screen when the PC
Camera software is run.

You have selected an external display as the default display device. The PC Camera application
software needs to be run while the default notebook LCD is the selected display device. 
After a camera picture is obtained on the default notebook LCD, you may then use the Fn + F7 to
toggle through the display modes (give the screen time to refresh).
If you have selected an external display as your display device do not run the PC Camera
software application until you have switched back to the notebook LCD.

A file cannot be copied
to/from a connected
Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is supported in one
direction only (simultaneous data transfer is not supported). If you are copying a file from
your computer to a Bluetooth enabled device, you will not be able to copy a file from the Bluetooth
enabled device to your computer until the file transfer process from the computer has been
completed

The Bluetooth module is
off after resuming from
Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state.
Use the key combination (Fn + F12) to power on the Bluetooth module after the computer
resumes from Sleep.

Problem Possible Cause - Solution
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No sound can be heard
through an HDMI
connected display
device.

You have not configured the HDMI audio output. See “HDMI Audio Configuration” on page 2 -
8.

You are experiencing
problems with image
distortion in a 3D game
(or any 3D program)
when the computer is
powered by the battery.

Where this is the case, install the beta video driver version provided on the Device Drivers &
Utilities +User’s Manual disc.

1. Insert the Device Drivers & Utilities + User’s Manual disc and click Browse 
CD/DVD.

2. The driver is located in the following location on the disc:
Drivers\02Video(beta)\.

3. Double-click the executable setup file and follow the on-screen instructions to 
install the driver.

Problem Possible Cause - Solution
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When the battery is being
used to power the system
in an environment with an
ambient temperature of
below 10C/50F, the
battery reaches a low
level very quickly.

This can occur as the battery cell performs poorly in a low temperature environment, especially
with a discharge rate of over 2C. Systems powered by the battery will perform normally at
environmental temperatures over 10C/50F. To use the system at environmental temperatures
below 10C/50F, it is recommended that the system is powered by the AC/DC adapter.

Battery Notes:

Note that when the the battery capacity is measured it may read less than the 5300mAh indicated
on the label, and possibly less than 5000mAh. This can be due to either of the following factors:

• The battery capacity listed on the label is defined by cell character specification. There 
is a -5% capacity tolerance based on a test at 0.2C charge/0.2C discharge. Therefore 
5035mAh (-5% of 5300mAh) meets the battery capacity specification listed.

• This system runs with a 0.6C charge/1C~2.5C discharge rate. The higher system charge/
discharge rate can result in a lower battery capacity measurement reading.

Problem Possible Cause - Solution
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You have a RAID
enabled and the system
will not boot to Windows.

You may need to recover the RAID volumes.

1. As the computer starts up press Ctrl + i to enter RAID configuration menu
2. If the RAID volume’s Physical disks are marked in red, then press 4.Recovery 

Volume Options.
3. If you cannot access 4.Recovery Volume Options (i.e. it is grayed out) then press 

5.Acceleration Options.
4. Press Enter and return to the main menu, then press 4.Recovery Volume 

Options.
5. Follow the on screen instructions to recover the Physical disks.
6. If only one of the physical disks now appears green, then press 6.Exit to save the 

changes and exit and boot to Windows.
7. When Windows is loaded run the Intel® Matrix Storage Console from the Intel® 

Matrix Storage Manager in the Programs/All Programs menu.
8. Click View > Advanced Mode.
9. Right-click on the RAID volume and select either Verify Volume Data or Verify 

and Repair Volume Data.
10. The verification or verification and repair process will run and display progress.
11. A dialog box will display the final status of the verification or verification and repair 

status.

Problem Possible Cause - Solution
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Bluetooth Connection Problems
If you are experiencing problems connecting to some Bluetooth devices (in particular certain mobile phones and
headsets) it maybe necessary to download and install the Windows Mobile Device Center software (for Win-
dows Vista and Windows 7). Go to the Microsoft website and search for the Microsoft Windows Device Center
Driver for Windows Vista (64-bit or 32-bit) and Windows 7 (64-bit or 32-bit), and then download the driver. 

1. Install the Microsoft Windows Device Center Driver as appropriate for your operating system.
2. Windows Vista will automatically configure the driver for you, however Windows 7 requires further configuration.
3. Make sure the Bluetooth device is powered on.
4. Go the Windows 7 control panel and double-click Device Manager (Hardware and Sound > Devices and 

Printers).
5. Bluetooth Peripheral Device(s) will be listed under Other Devices (note this will only be listed if you have 

connected, or tried to connect to, a Bluetooth device previously).

Figure 8 - 1 - Device Manager


Bluetooth Peripheral Devices

You will need to repeat the procedure
listed here for all Bluetooth Peripher-
al Devices listed under Other Devices
i.e. until there are no more Bluetooth
Peripheral Devices listed under this
menu heading.
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6. Right-click Bluetooth Peripheral Device and click on Update Driver Software.
7. Click Browse my computer for driver software.
8. Click Let Me pick from a list of device drivers on my computer.

Figure 8 - 2 - Browse my computer.../Let me pick from...

9. Select Bluetooth Radios from the list.

Figure 8 - 3 - Select Bluetooth Radios
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10. A list of drivers will appear with Manufacturer on one side and Model in the other. 
11. Choose Microsoft Corporation (make sure you choose the full name Microsoft Corporation and do not 

choose Microsoft - Note that you must have installed the Microsoft Windows Device Center Driver for 
Microsoft Corporation to appear in the list). 

12. Select Windows Mobile-based device support from the Model list.

Figure 8 - 4 - Select Device Driver

13. Click Next > Yes and the driver will install.
14. Click Close to complete the installation.

Make sure you select
Microsoft Corporation
Bluetooth Connection Problems 8 - 17
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15. The Device Manager should now display the Windows Mobile-based device support under Bluetooth 
Radios.

16. You will need to repeat the process for any other Bluetooth Peripheral Devices listed under Other Devices.

Figure 8 - 5 - Device Manager - Bluetooth Radio
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Intel® WLAN & Bluetooth V3.0+HS Combo Modules
Note that, at the time of going to press Intel® Centrino Advanced 6230 WLAN & Bluetooth V3.0+HS combo
modules use the standard Bluetooth configuration in Windows 7 (see “Bluetooth Configuration in Windows 7”
on page 7 - 55). Do not use the Bluetooth & WLAN Combo settings information outlined from page 7 - 47 to
page 7 - 53.

Driver Release Update
Note also that, at the time of going to press, these modules do not support high speed Bluetooth (V3.0) data trans-
fer. Intel have scheduled a driver release to allow this module to support high speed data transfer, so please check
with Intel or your service center for details.
Bluetooth Connection Problems 8 - 19
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Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the ports & jacks which allow your computer to commu-
nicate with external devices, connect to the internet etc.
Interface (Ports & Jacks) A - 1
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Ports and Jacks

Item Description

Card Reader The card reader allows you to use the following digital storage cards:

MMC (MultiMedia Card) / RSMMC
SD (Secure Digital) / Mini SD / SDHC / SDXC

MS (Memory Stick) / MS Pro / MS Duo

Push the card into the slot and it will appear as a removable device.

Cable (CATV) 
Antenna Jack

Use this jack to connect a CATV cable if you have included the optional Mini-PCI TV Tuner in
your purchase.

Consumer Infrared 
Transceiver

The consumer infrared transceiver at the front of the computer allows the computer to
communicate with the remote control unit supplied with the optional Mini-PCI TV Tuner.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

DVI-Out Port The DVI-Out (Digital Visual Interface) Port is a video connector interface. This allows you to
connect an external monitor, TV or Flat Panel Display etc. as a display device (see “Configuring
an External Display using the NVIDIA Control Panel” on page B - 7) by means of a DVI cable.
If you are using an older type of monitor you will need to use a converter to convert the signal
from DVI to VGA.
A - 2 Interface (Ports & Jacks)
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e-SATA Port This e-SATA (external Serial Advanced Technology Attachment) port allows you to plug-in
external Serial ATA hard drives.

HDMI-Out Port The HDMI-Out (High-Definition Multimedia Interface) port is an audio/video connector
interface for transmitting uncompressed digital streams. This allows you to connect an external
monitor, TV or Flat Panel Display etc. as a display device (see “Configuring an External
Display using the NVIDIA Control Panel” on page B - 7) by means of a HDMI cable. Note that
HDMI carries both audio and video signals (see “HDMI Audio Configuration” on page 2 -
8).

Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s volume
to a reduced level before connecting to this jack.

Line-In Jack The Line-In jack allows you to play audio sources through the computer’s speakers. Note that
audio input through Line-in will default to the mute setting. To set up your audio sources to play
through the Line-in jack go to the Sound  control panel and make sure the Mute box is not
ticked.

Microphone-In Jack Plug an external microphone in to this jack to record on your computer.

Item Description

e-SATA 

HDMI-OUT
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Mini-IEEE 1394b Port This allows high-speed connection to various peripheral devices, e.g. external disk drives and
digital cameras (see note below).

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

Item Description


IEEE 1394b

The Mini-IEEE 1394 ports only support SELF POWERED IEEE 1394 devices.
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USB 2.0/1.1 Ports

USB 3.0 Port

These USB (Universal Serial Bus) 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are
for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals
such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be
plugged into the computer, and unplugged from the computer, without the need to turn the system
off (if the power rating of your USB device is 500mA or above, make sure you use the power
supply which comes with the device).

The USB 3.0 ports are denoted by their blue color; USB 2.0 ports are colored black. USB 3.0 will
transfer data much faster than USB 2.0, and is backwards-compatible with USB 2.0.

Note that the USB 3.0 port requires a driver installation (see “USB 3.0” on page 4 - 8), does not
support wake on USB and is not operational under DOS.

Item Description

3.0
Interface (Ports & Jacks) A - 5
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Appendix B: NVIDIA Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 17.

NVIDIA Video Driver Installation
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

1. Insert the Device Drivers & Utilities + User’s Manual disc and click Install 
Drivers (button).

2. Click 2.Install Video Driver > Yes.
3. Click AGREE AND CONTINUE (button) to accept the terms of the 

license agreement.
4. Click NEXT.
5. Click the RESTART NOW button to restart the computer.


Video Card Options

Note that card types, specifications and drivers are subject to continual updates and chang-
es. Check with your service center for the latest details on video cards supported. Note that
not all video card options for this computer model series support SLI configuration (see
“Video Adapter Options” on page D - 2, or contact your service center for details).
NVIDIA Video Driver Installation B - 1
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NVIDIA Control Panel (Win 7)
More advanced video configuration options are provided in the NVIDIA Control
Panel tab.

1. Open the Display (see page 1 - 18) control panel.
2. Click Advanced Settings (button).
3. Click GeForce..... (tab).
4. Click Start the NVIDIA Control Panel to make any video adjustments.

OR
1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the

menu if you are in Control Panel Home).


NVIDIA Control 

Panel 

To access the Ge-
Force..... control panel
from the desktop; right-
click the desktop, then
click NVIDIA Control
Panel.

Figure B - 1
NVIDIA GeForce..... 

Control Panel
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The NVIDIA Control Panel provides additional video configuration controls and
tools which allow quick access to features such as display configuration, 3D Settings
and Help menus etc.


Navigating the 
Control Panel

Navigate through the
control panels in much
the same way as you
would a web page.
Click on the sub-head-
ing tasks in the left
menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

Figure B - 2
NVIDIA Control 

Panels
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The Help menus provide index and search features, and direct links to the NVIDIA
website etc.

Figure B - 3
Help Menu
B - 4 NVIDIA Control Panel (Win 7)
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Display Devices
Note that you can use a DVI cable connected to the DVI-Out port, or an HDMI
(High-Definition Multimedia Interface) cable connected to the HDMI-Out port to
connect an external display (if you are using an older type of monitor you can use a
converter to convert the signal from DVI to VGA). See your display device manual
to see which formats are supported.

1. The built-in LCD.
2. An external display connected to the DVI-Out Port.
3. An external display/TV (if the TV supports an HDMI connection) connected to the

HDMI-Out Port.


Display Devices

Besides the built-in
LCD, you can also use
an external monitor/flat
panel display as your
display device. The dis-
play options are:

• The built-in LCD.
• An external display 

connected to the DVI-
Out port.

• An external display 
connected to the 
HDMI-Out port.

Note that HDMI sup-
ports video and audio
signals.

DO NOT use the Fn +
F7 key combination to
toggle through display
options when SLI is en-
abled.


Monitor and TV Tuner

If you are connecting both a monitor/flat panel display to the DVI-Out Port, and a cable/aer-
ial to the optional TV Tuner module, make sure you attach the cable/aerial to the TV Tun-
er first, then the monitor.
Display Devices B - 5
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Display Modes
Single Display Mode
Only one of your displays is used.

Duplicate Displays
Duplicate simply shows an exact copy of the Primary display desktop on the other
display(s). This mode will drive multiple displays with the same content.

Extend Desktop
Extend Desktop treats both connected displays as separate devices, and they act as
a virtual desktop resulting in a large workspace. When enabled, you can drag any
icons or windows across to the other display desktop. It is therefore possible to have
one program visible in one of the displays, and a different program visible in the oth-
er display.


SLI Configuration & 

Multiple Displays

Note that if SLI configu-
ration is enabled only a
Single display may be
used as the display de-
vice.

DO NOT use the Fn +
F7 key combination to
toggle through display
options when SLI is en-
abled. SLI supports only
a Single display, and at-
tempting to configure
dual displays may cause
an error. Use the NVID-
IA control panel to select
the display to be used.
B - 6 Display Modes
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Configuring an External Display using the NVIDIA Control Panel
You can use the NVIDIA control panel to configure any attached displays.

1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see page B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up

multiple displays.
4. Any attached display will appear under “1.Select the displays you want to use.”

5. Click the tickbox alongside any display you wish to use.
6. Click Apply > Yes to save any changes made.


Display Not Shown

If the attached display
does not appear in the
“1.Select the displays
you want to use.” win-
dow, click “My Display
is not shown...” and
then click the appropri-
ate button to force de-
tection of the missing
display.

Figure B - 4
Set Up Multiple 

Displays
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Duplicating the Displays
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see page B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up

multiple displays.
4. Any attached display will appear under “1.Select the displays you want to use.”
5. Click the tickbox alongside any display you wish to use.
6. Right-click one of the display icons and click “Duplicate displays....” (select which

is to be the primary display) to duplicate the desktop on both displays.

7. Click Apply > Yes to save any changes.

Figure B - 5
Duplicate 
Displays

Select Apply > Yes 

Right-click to select Duplicate displays
 and which is to be used as the primary clone   

to save changes 
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Extending the Display
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to NVIDIA Control Panel (see page B - 2).
3. Double-click Display (if the sub-menus are not visible), and then click Set up

multiple displays.
4. Click to select a primary display under “1.Select the displays you want to use.”
5. Right-click one of the display icons and click “Extend Desktop on this display....”

to extend the desktop across both displays.

6. Click Apply > Yes to save any changes.

Figure B - 6
Extend the Display

Click to select the display to be used as the primary display

Right-click Extend desktop on this display 

Select Apply > Yes 
to save changes 
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Changing the Primary Display on Extended Displays
1. If you want to switch the primary display if the displays are extended then right-

click the secondary display icon.
2. Select Make this the Windows primary display.
3. Click Apply > Yes to save the change.

Figure B - 7
Switch Primary 

Display Select Apply > Yes 

Right-click to select the secondary display
and select Make this the Windows primary display.

to save changes 
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Attaching Other Displays (Win 7)
Configuring an External Display in Windows 7
1. Attach your external display to the DVI-Out Port or HDMI-Out port, and turn it on.
2. Go to the Screen resolution control panel.
3. Click the Detect button.
4. The computer will then detect any attached displays.


Function Key 
Combination

You can use the Fn + F7
key combination to toggle
through the display op-
tions:

• Notebook Only
• External Display Only
• Notebook + External 

Display

Make sure you give the
displays enough time to
refresh.

DO NOT use the Fn + F7
key combination to toggle
through display options
when SLI is enabled.

Figure B - 8
Screen Resolution 

Multiple Displays

(Win 7)
Attaching Other Displays (Win 7) B - 11
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5. You can configure the displays from the Multiple Displays menu.

• Duplicate these displays - Shows an exact copy of the main display desktop on 
the other display(s)

• Extend these displays - Treats both connected displays as separate devices
• Show desktop only on 1/2 - Only one of your displays is used.

Figure B - 9 

Screen Resolution 

Multiple Display 

Options

(Win 7)
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Using the Windows Logo Key  + P Key Combination to Switch Displays
You can also use the  + P key combination to quickly change display configura-
tion and modes (this is particularly useful when attaching a projector) in Windows 7.

1. Attach your external display to the external monitor port and turn it on.
2. Press the  + P key combination.
3. An on-screen menu will pop up.
4. Use the cursor keys (or  + P) to select the appropriate configuration from the

menu, and press Enter to confirm the selection.

Figure B - 10
 + P Display 

Configuration 

Selection

(Win 7)
Attaching Other Displays (Win 7) B - 13
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SLI Multi GPU Configuration
This computer features an NVIDIA Scalable Link Interface (SLI) that improves
graphic quality and performance by combining dual NVIDIA GPUs (two video
cards are required) in a single system. To enable/disable SLI Configuration:

1. Go to NVIDIA Control Panel (see page B - 2).
2. Click “+” next to 3D Settings if its sub-items are not shown and then click Set SLI 

and PhysX configuration.

3. Click “Maximize 3D Performance” under “SLI configuration:”.
4. Click to select “PhysX settings; Auto-select (recommended) is the default setting.
5. Click Apply and Restart Now to restart the computer (see over).


Video Card 

Options

Note that card types,
specifications and driv-
ers are subject to con-
tinual updates and
changes. Check with
your service center for
the latest details on
video cards supported.
Note that not all video
card options for this
computer model series
support SLI configura-
tion (see “Video
Adapter Options” on
page D - 2, or contact
your service center
for details).

Figure B - 11
Set SLI 

Configuration

Select Restart Now 
to restart the computer 
B - 14 SLI Multi GPU Configuration



NVIDIA Video Driver Controls

B

SLI Multi GPU Configuration & Battery Power
Note that due to the high power and system demands created by enabling SLI Con-
figuration, you should not enable SLI configuration if your computer is powered
by battery only. If you attempt to run an SLI configuration when the computer is
powered by the battery only, then system problems may occur.

• If the computer is currently powered by battery only do not enable SLI config-
uration. 

• If you have currently enabled SLI configuration, and the computer is powered 
by the AC/DC adapter, do not switch to battery power only (or go to the 
NVIDIA Control Panel and disable SLI configuration before switching to bat-
tery power only).


SLI Configuration & 

Multiple Displays

Note that if SLI configu-
ration is enabled only a
Single display may be
used as the display de-
vice.

DO NOT use the Fn +
F7 key combination to
toggle through display
options when SLI is en-
abled. SLI supports only
a Single display, and at-
tempting to configure
dual displays may cause
an error. Use the NVID-
IA control panel to select
the display to be used.
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Enabling TV Display
To display desktop images on a TV, connect the TV to your computer by using an
HDMI cable/DVI cable from the TV to the HDMI-Out port/DVI-Out port (if sup-
ported by your TV).

You will need to enable the TV display from the NVIDIA Control Panel as per the
instructions on B - 7. The TV will appear as a display option (1. Select the displays
you would like to use.) when attached to the appropriate port. Apply the settings,
and then click Yes to save the changes.


Detect Displays

To get a full range of dis-
play options click “My dis-
play is not shown in the
list...”.

HDMI Audio Setup

See “HDMI Audio Con-
figuration” on page 2 -
8 for instructions on con-
figuring audio for HDMI
display devices. 

Set up your external dis-
play (TV or LCD) for
HDMI input (see your
display device manual).

Figure B - 12
Set Up Multiple 

Displays 

(with TV connected) 
B - 16 Enabling TV Display
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Changing the TV Signal Format
1. When the TV is enabled as a display device click the sub-menus under Video & 

Television.
2. Click “Change the signal or HD format”.
3. Select the connector or format you want to use (the menu that appears will depend

upon your type of connector).
4. Apply the settings, and then click Yes to save the changes.

Figure B - 13
Change the Signal or 

HD Format
Enabling TV Display B - 17
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The NVIDIA Control Panel provides additional configuration controls to adjust the
TV settings in the Video & Television menu.

Figure B - 14
NVIDIA Control 

Panels

(Video & 

Television)
B - 18 Enabling TV Display
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Appendix C: AMD Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 17.

Video Driver Installation
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

Video (VGA)
1. Click 2.Install Video Driver > Yes.
2. Click Next > Install (button).
3. Click the Express (or Custom if you prefer to manually configure the 

driver installation settings) button and click Next.
4. Click Accept (button) and click Yes.
5. Click Finish > Yes to restart the computer.
6. After the computer has restarted, click Restart Now to restart again to 

refresh the video driver.

Note: After installing the video driver go to the Display/Display Settings control
panel to adjust the video settings to the highest resolution.


Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your service center for
the latest details on vid-
eo cards supported (see
“Video Adapter Op-
tions” on page D - 2/D
- 3, or contact your
service center for de-
tails).
Video Driver Installation C - 1
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Catalyst™ Control Center
Adjust the video settings from the Catalyst™ Control Center.

1. Right-click the desktop and select Catalyst Control Center.
OR

2. Click Advanced settings in the Screen Resolution control panel (see “Video 
Features” on page 1 - 17), click the Catalyst Control Center tab and then click 
ATI Catalyst control Center.


Taskbar Icon

The CatalystTM Control
Center can also be ac-
cessed by double-clicking
the icon   in the task-
bar (or by right-clicking the
icon and selecting Config-
ure Graphics).

If you don’t see the icon in
the taskbar, click Prefer-
ences in the CatalystTM

Control Center, and select
Enable System Tray
Menu (see over).

Figure C - 1
Catalyst Control 

Center Access

Right-Click
for Menu
C - 2 Catalyst™ Control Center
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Catalyst™ Control Center Preferences
The Preferences button in the Catalyst™ Control Center menu allows you to con-
figure the control panel settings. You can view the control panel in either Standard
View or Advanced View. To display Standard View or Advanced View:

1. Open the Catalyst™ Control Center.
2. Click the Preferences button and select either Advanced View or Standard View.


Preferences & 

Views

You can switch between
Advanced and Stan-
dard views from the
Preferences menu.

Figure C - 2
Catalyst Control 

Center Preferences

Right-Click
for Menu
Catalyst™ Control Center C - 3
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Standard View
The Standard View menus feature a series of menu headings with clickable sub-
menus which allow you to adjust Desktops and Displays, Power, Video, Gaming
and Information. Click the Start button to access the top level menu from any sub-
menu heading.

Figure C - 3
Catalyst Control 

Center Standard View
C - 4 Catalyst™ Control Center
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Advanced View
The Advanced View menus display all the menu headings as a series of buttons on
the left. Click the arrows in any button to display the sub-menus (note all the figures
in the remainder of this chapter are in Advanced View).


Sub-Menus

Click a menu button to
expand any sub-menus,
and then click the appro-
priate sub-menu head-
ing to configure the item.

Figure C - 4
Catalyst Control 

Center Advanced View


Catalyst Control Center Versions

Due to driver updates your Control Center screens may appear slightly different from those pictured on
these pages.
Catalyst™ Control Center C - 5
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The Catalyst™ Control Center provides additional video configuration controls
and tools which allow quick access to features such as display options, 3D Settings,
color, power and Information menus etc. Adjust settings from the options in the sub-
menus.


Help Menus

Press F1 to bring up
Help menu. Click the
question mark icon  in
the top right to bring up
help on a specific page.

Figure C - 5
ATI Catalyst Control 

Center Advanced 

Menus
C - 6 Catalyst™ Control Center
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Display Devices & Options
Note that you can use a DVI cable connected to the DVI-Out port, or an HDMI
(High-Definition Multimedia Interface) cable connected to the HDMI-Out port to
connect an external display. See your display device manual to see which formats
are supported.

Display Mode Description

Single One of the connected displays is used as the display device

Duplicate Both connected displays output the same view

Extend
Both connected displays are treated as separate devices, act as a 
virtual desktop and may be configured independently

Table C - 1
Display Modes
Display Devices & Options C - 7
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Configuring an External Display In the CCC
You can use the Catalyst™ Control Center to configure any attached displays.

1. Attach your external display to the external monitor port/HDMI-Out port, and turn it on.
2. Open the Catalyst™ Control Center.
3. Select Desktop Management from the menu on the left (click the arrow to expand

the menu) and click Creating and Arranging Desktops.
4. Attached displays will appear in the lower part of the screen (click Detect Displays

to find any attached displays that do not automatically appear).


Detect Displays

Click Detect Displays
(button) to automati-
cally update the at-
tached display
information.

You can set a prefer-
ence for automatic dis-
play detection in
Advanced Display
Settings (Desktop
Management). You
can choose to have at-
tached displays auto-
matically detected
when the CCC is
opened, or to use man-
ual detection only.

Figure C - 6
 Desktop 

Management

Click Detect Displays
to find any attached
displays that do not
automatically appear. 
C - 8 Display Devices & Options
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5. Click the triangle icon  (or right-click the display icon) on the attached display
icon at the bottom to bring up the options (e.g Duplicate or Extend).

6. Select an option from the menu (click Continue if required), and click Yes to
accept the settings.

7. An extra menu button (e.g. My VGA Displays) will be available to offer
configuration options for your external display (depending on the type of display
attached).


Disable Displays

If you want to disable
any of the displays,
right-click the display
icon at the bottom of
the screen and click
Disable.

Figure C - 7
 Desktop 

Management with 

External Display

Attached displays will appear here.
Display Devices & Options C - 9
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My Digital Flat-Panels
An additional menu button entitled My Digital Flat-Panels will appear (depending
on the type of display attached) when an external display is attached. This menu al-
lows you to configure the properties of the external display. After making any ad-
justments you may need to click the Apply button to confirm the changes.

Figure C - 8
 My Digital Flat-

Panels
C - 10 Display Devices & Options
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HDTV Support
If your flat panel supports HDTV functions then this can be configured from My
Digital Flat-Panels > HDTV Support (Digital Flat-Panel).

Figure C - 9
 My Digital Flat-

Panels 

(HDTV Support)
Display Devices & Options C - 11
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Configuring an External Display In Windows 7 
1. Attach your external display to the external monitor port/HDMI-Out port, and turn it on.
2. Go to the Screen resolution control panel (see “Video Features” on page 1 - 17).
3. Click the Detect button.
4. The computer will then detect any attached displays.


Function Key 
Combination

You can use the Fn + F7
key combination to toggle
through the display op-
tions:

• Notebook Only
• External Display Only
• Notebook + External 

Display

Make sure you give the
displays enough time to
refresh.

Figure C - 10
Screen Resolution 

Multiple Displays

(Win 7)
C - 12 Display Devices & Options
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5. You can configure the displays from the Multiple Displays menu.

• Duplicate these displays - Shows an exact copy of the main display desktop on 
the other display(s)

• Extend these displays - Treats both connected displays as separate devices
• Show desktop only on 1/2 - Only one of your displays is used.

Figure C - 11 

Screen Resolution 

Multiple Display 

Options

(Win 7)
Display Devices & Options C - 13
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Using the Windows Logo Key  + P/Fn +F7 Key Combination to Switch 
Displays
You can also use the  + P/Fn + F7 key combination to quickly change display
configuration and modes (this is particularly useful when attaching a projector) in
Windows 7.

1. Attach your external display to the external monitor port and turn it on.
2. Press the  + P/Fn + F7 key combination.
3. An on-screen menu will pop up.
4. Use the cursor keys (or  + P/Fn + F7) to select the appropriate configuration

from the menu, and press Enter to confirm the selection.
Figure C - 12

 + P/Fn + F7 

Display 

Configuration 

Selection

(Win 7)
C - 14 Display Devices & Options
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PowerPlay™
When enabled, PowerPlay™ can be used to automatically set to adjust the graphics
processor settings for higher performance or longer battery life when the system is
either Plugged In or on Battery.

Figure C - 13
PowerPlay™
Display Devices & Options C - 15
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Gaming
The Gaming menu includes configuration options for AMD CrossFireX™. AMD
CrossFireX™ combines  the processing power of multiple GPUs to s single display,
and this may be enabled/disabled from the AMD CrossFireX™ Configuration
menu (this sub-menu is also available in the Performace menu).

Figure C - 14
Gaming AMD 

CrossFireX™ 

Configuration
C - 16 Display Devices & Options
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HDMI Audio Configuration
HDMI (High-Definition Multimedia Interface) carries both audio and video signals.
Configure the audio output as per the instructions below.

1. Connect a device with HDMI support to the HDMI-Out port.
2. Click Start, and click Control Panel (or point to Settings and click Control Panel).
3. Click Sound  (Hardware and Sound), and click Playback (tab).
4. Depending on your display, the playback device may be selected automatically; 

however in some cases you may need to select the audio device and click Set Default 
(button) or select Realtek Digital Output and click Set Default (button).

Figure C - 15
Sound - HDMI 

Device 

(Set Default)
HDMI Audio Configuration C - 17
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5. Double-click the connected HDMI device (or right-click and select Properties) to
adjust the HDMI settings from the control panel tabs.

6. Click OK to close the control panel (see notes overleaf).

Figure C - 16
HDMI Device 

Properties
C - 18 HDMI Audio Configuration
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HDMI Notes

• Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.

• To play audio sources through your external display’s (TV or LCD) speakers 
you will need to go to the audio configuration control panel on the display and 
configure the audio input accordingly (see your display device manual).

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “Configuring an

External Display In the CCC” on page C - 8.
3. Set up your external display (TV or LCD) for HDMI input (see your display device

manual).
4. You can now play video/audio sources through your external display.


Other Applications

If you are using a third
party application to
play DVDs etc. from
any attached DVD de-
vice, you will need to
consult the applica-
tion’s documentation
to see the appropriate
audio configuration
(the application must
support digital to ana-
log translation).
HDMI Audio Configuration C - 19
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Appendix D: Specifications


Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.
Specifications D - 1
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Processor

Intel® Core i7 Processor:
===============================
i7-990x (3.46GHz)
6.4 GT/s on QPI, 12M L3 Cache, 32nm (32 
Nanometer), LGA1366 Package, TDP130W

i7-980x (3.33GHz)
6.4 GT/s on QPI, 12M L3 Cache, 32nm (32 
Nanometer), LGA1366 Package, TDP130W

i7-975 (3.33GHz)
6.4 GT/s on QPI, 8M L3 Cache, 45nm (45 
Nanometer), LGA1366 Package, TDP130W

i7-950 (3.06GHz)
4.8 GT/s on QPI, 8M L3 Cache, 45nm (45 
Nanometer), LGA1366 Package, TDP130W

i7-930 (2.8GHz)
4.8 GT/s on QPI, 8M L3 Cache, 45nm (45 
Nanometer), LGA1366 Package, TDP130W

i7-920 (2.66GHz)
4.8 GT/s on QPI, 8M L3 Cache, 45nm (45 
Nanometer), LGA1366 Package, TDP130W

Core Logic

Intel® X58 + ICH10R

Display

17.3" (43.94cm) FHD (1920 * 1080), 16:9 
Wide Screen LED Backlit LCD

Memory

Triple Channel DDRIII (DDR3)

Three 204 Pin SO-DIMM Sockets 
Supporting DDRIII (DDR3) 1066MHz/
1333MHz Memory Modules

Memory Expandable up to 12GB
Compatible with 1GB, 2GB or 4GB Modules 

Video Adapter Options

nVIDIA® GeForce GTX 485M PCIe 
Video Card
2GB GDDR5 Video RAM On Board
Supports PCIe * 16
Supports Microsoft DirectX® 11.0
Supports HDCP
Supports DVI Dual Link
Supports HDMI 1.4
NVIDIA PhysX™
GeForce CUDA™ Technology

Video Adapter Options

nVIDIA® GeForce GTX 470M PCIe 
Video Card
1.5GB GDDR5 Video RAM on board
Supports PCIe * 16
Supports Microsoft DirectX® 11.0
Supports HDCP
Supports HDMI 1.4
Supports SLI
Supports DVI Dual Link

nVIDIA® GeForce GTX 460M PCIe 
Video Card
1.5GB GDDR5 Video RAM on board
Supports PCIe * 16
Supports Microsoft DirectX® 11.0
Supports HDCP
Supports HDMI 1.4
Supports SLI
Supports DVI Dual Link

See over for more video adapter information
D - 2 Specifications
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Video Adapter Options

nVIDIA® Quadro FX 3800M PCIe Video 
Card (Does not support SLI)
1GB GDDR3 Video RAM On Board
Supports PCIe * 16
Supports Microsoft DirectX® 10.1
Supports HDCP
Supports DVI Dual-Link
Supports Open GL 3.1

nVIDIA® Quadro 5010M PCIe Video 
Card (Does not support SLI)
4GB GDDR5 Video RAM On Board
Supports PCIe * 16
Supports Microsoft DirectX® 11.0
Supports HDCP
Supports DVI Dual-Link
Supports Open GL 4.1

Video Adapter Options

nVIDIA® GeForce GTX 560M PCIe 
Video Card
1.5GB GDDR5 Video RAM On Board
Supports PCIe * 16
Supports Microsoft DirectX® 11.0
Supports HDCP
Supports DVI Dual Link
Supports HDMI 1.4a
NVIDIA PhysX™
GeForce CUDA™ Technology
Supports SLI

nVIDIA® GeForce GTX 580M PCIe
Video Card
2.0GB GDDR5 Video RAM On Board
Supports PCIe * 16
Supports Microsoft DirectX® 11.0
Supports HDCP
Supports DVI Dual Link
Supports HDMI 1.4
NVIDIA PhysX™
GeForce CUDA™ Technology

Video Adapter Options

AMD Radeon™ HD 6970M
PCIe * 16 Video Card (Crossfire x PCIe * 
16)
2GB GDDR5 Video RAM On Board
Supports Microsoft DirectX® 11.0
Supports HDCP
Supports Crossfire

AMD Radeon™ HD 6990M
PCIe * 16 Video Card (Crossfire x PCIe * 
16)
2GB GDDR5 Video RAM on board
Microsoft DirectX® 11 compatible
Supports HDCP

BIOS

One 16Mb Flash ROM
Phoenix™ BIOS

See over
Specifications D - 3



Specifications

D

Storage

Up to three (Factory Option) 
Changeable 2.5" 9.5 mm (h) SATA 
(Serial) Hard Disk Drives supporting 
RAID level 0/1/5

One 12.7 mm Super Multi/Blu-Ray 
Combo/Blu-Ray Writer SATA Optical 
Device Drive (Factory Option)

Audio

High Definition Audio
S/PDIF Digital Output
UAA (Universal Audio Architecture)
Built-In Microphone
5 Built-In Speakers and One Sub woofer
Dolby Home Theater Certified

Keyboard & Pointing Device

Full Size Winkey Keyboard with Numeric 
Keypad
Built-In TouchPad (with Multi Gesture 
Functionality)
Touch Sensor Instant Keys 
(Mute, Vol Control, Bluetooth, WLAN & 
Camera)

Slots

One ExpressCard/34 Slot

Three Mini Card Slots:

Slot 1 for PCIe WLAN Module
Slot 2 for PCIe TV Tuner Module

Card Reader

Embedded Multi-In-1 Card Reader 
- MMC / RSMMC
- SD / Mini SD / SDHC / SDXC
- MS / MS Pro / MS Duo

Note: Some of these cards require PC 
adapters that are usually supplied with 
the cards.

Interface

Two USB 3.0 Ports (No DOS Support)
Three USB 2.0 Ports
One HDMI-Out (High-Definition 
Multimedia Interface) Port-1.4 (with 
HDCP Support)
One DVI-Out Port (with CRT out)
One eSATA Port
One S/PDIF Out & Surround Out Combo 
Jack (supporting external 7.1ch audio)
One Headphone/Speaker-Out Jack
One Microphone-In Jack
One Line-In Jack
One Mini-IEEE1394b Port with TI 
Controller
One RJ-45 LAN Jack
One DC-In Jack
One CATV-In Jack (for TV Tuner)
One Consumer Infrared Transceiver for 
TV Tuner Remote Controller
D - 4 Specifications
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Communication

Built-In 10/100/100 Base-TX Ethernet LAN

Bluetooth v2.1 + EDR (Enhanced Data 
Rate) Module (Factory Option)

Combo Bluetooth v3.0+HS & 802.11b/g/n 
Wireless LAN Half Mini-Card Module 
(Factory Option)

Intel® Centrino® Advanced-N 6230 2*2
(802.11 a/g/n) Half Mini-Card PCIe WLAN +
Bluetooth V3.0+HS Combo Module (Facto-
ry Option)

Intel® Centrino® Advanced-N 6200 2 * 2
(802.11 a/g/n) Half Mini-Card PCIe WLAN
Module (Factory Option)

Intel® Centrino® Ultimate-N 6300 3 * 3
(802.11 a/g/n) Half Mini-Card PCIe WLAN
Module (Factory Option) 

3rd Party 802.11b/g/n Wireless LAN PCIe 
Interface Half Mini-Card Module (Factory 
Option)

2.0M Pixel PC Video Camera Module 
with USB Interface

Hybrid TV Tuner Module (Factory 
Option)

Security

Security (Kensington® Type) Lock Slot
BIOS Password
Fingerprint Reader Module
Trusted Platform Module V1.2

Operating System

Windows® 7
Note that the TV Tuner module (factory) 
option in is supported by the Windows 
Media Center software. Windows Media 
Center is not included in Starter or 
Home Basic versions of Windows 7.

Power Management

Supports Wake on LAN
Supports Wake on USB (for USB 2.0 
Ports Only)

Power

Full Range AC/DC Adapter – AC in 100 - 
240V, 50 - 60Hz DC Output 20V, 15A 
(300 Watts)

Removable Polymer Smart Lithium-Ion 
78.44Wh Main Battery

Environmental Spec

Temperature
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Physical Dimensions & Weight

419mm (w) * 286mm (d) * 56.5 - 60.7mm 
(h)

5.5kg with Single nVIDIA® GeForce GTX 
485M Video Card, ODD and 78.44Wh 
Battery
Specifications D - 5
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